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1 ABOUT THIS REFERENCE GUIDE 

1.1 IMPORTANT: ACQUISITION SYSTEM CONFIGURATION 

REMINDER: Refer to the same section in the Common Scratch & Indentation 
reference guide. 

 
 

1.2 INTRODUCTION 

 
1.2.1 ABOUT THE INDENTATION SOFTWARE 

By choosing an Indentation Tester from the complete range proposed by Anton 

Paar, the user benefits from all advantages of our powerful software: An easy to use 
window interface including numerous indentation measurement types, analysis 

methods, image management, statistics and advanced reporting functions. 
 
The Indentation Software (for Windows® 7 64 bits and Windows® 10) provided by 

Anton Paar enables a complete integration of various data in a single document. 
 

 
1.2.2 ENCLOSED CONTENT 

This document describes the Indentation Software features. 
 

Some Indentation Software features are common with Scratch Software. If the 
information is not described in this document, refer to the Common Scratch & 

Indentation software reference guide. 
 

For explanations (set up and use) of each Indentation head, refer to its 
corresponding user manual or reference guide. 
 

For information concerning the Video Software, refer to the Video software 
reference guide. 

 
 
1.2.3 HOW TO USE THIS DOCUMENT? 

If the components and software (Indentation) are not yet installed on the 

acquisition system, refer to the Common Scratch & Indentation software 
reference guide in section Installation. Otherwise if they are installed, first refer 

to the Common Scratch & Indentation software reference guide in section 
Starting which describes how to start the software. 
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1.2.4 GENERAL NOTE 

In this document the images may differ from the actual product. 

 
The software print screen images that show V7.0.x or V8.0.x version are also 
applicable for V9.0.x version. 
 

'Indentation headʹ means Indentation measuring head. 
 
If not specified, the descriptions in this document concerns all following Indentation 

instruments of Anton Paar: 
 

• Step - MHT/MCT/NHT/UNHT/UNHT Bio, or UNHT HTV if <High temperature> 
radio button is selected in My configuration tab (section 2.1.1.2) 

 

• TTX-NHT/UNHT/UNHT Bio 
 

Otherwise each concerned platform/Table Top and/or Indentation head is 

mentioned. 
 
'Step' means it is applicable for all platform generations/types. Otherwise the 

concerned platform(s) is specified (e.g. Step 700, STeP 4…) 
 

If not specified, 'measurement(s)' means indentation measurement(s): 
 

• for single measurement 

OR 
• for matrix of measurements. 

 

'toolbar' means software main toolbar. 
 

'key(s)' means keyboard key(s). 
 
For troubleshooting see section 5. 

 
 

1.2.5 TYPOGRAPHICAL CONVENTIONS 

Refer to the same section in the Common Scratch & Indentation software 
reference guide. 
 

 
1.2.6 ABBREVIATIONS & SYMBOLS 

Physical quantity symbols are according to the ISO 14577 standard. 

 

Abbreviations 
Symbols 

Designations Units 

ADO adjust depth offset  

AFM Atomic Force Microscope (imaging head)  

Ap projected contact area m2 

CHM creep Martens hardness % 

CIT indentation creep % 
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COS Conscan confocal (imaging head)  

.DCF / .dcf dynamic (sinus) calibration file  

E* plane strain modulus Pa 

EIT indentation modulus Pa 

 (Epsilon) geometric constant  

Er reduced modulus Pa 

.FDOP / .fdop 
Saxonian (SIO) Institute of Surface Mechanics 
Software file extension 

 

F test force N 

Fmax maximum test force N 

h indentation depth under applied test force m 

hc contact depth of the indenter with the sample at Fmax m 

HIT indentation hardness Pa 

HM Martens hardness Pa 

hmax maximum indentation depth m 

hp permanent indentation depth m 

hr tangent indentation depth m 

HV Vickers hardness Vickers 

HVIT Vickers hardness calculated from HIT Vickers 

.INDBCK / .indbck 
Indentation Software configuration backup file 
extension 

 

.INI/.ini file initialization file  

m power law exponent  

MCT 

Micro Combi Tester (measuring head) 
applicable for: 

MCT : first generation 

MCT3 : new generation 

MCT3 V : Vacuum prepared new generation 

 

MHT 

Microindentation Tester (measuring head) 
applicable for, 

◦ MHT : first generation 

◦ MHT3 : new generation 

◦ MHT3 V : Vacuum prepared new generation 

 

.MIT / .mit Indentation Software document file extension  

NHT 

Nanoindentation Tester (measuring head) 
applicable for: 

NHT2 : second generation 

NHT3 : new generation 

NHT3 V : Vacuum prepared new generation 

 

 (Nu) Poisson’s ratio  

R2 (R^2) 
Coefficient of determination for the linear fit 
regression 

 

RIT indentation relaxation % 

O&P Oliver & Pharr  

S contact stiffness N/m 
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Step 

Surface Testing Platform 
 

applicable for new generation Step X00: 
 

Step 100 : for 1 head + optional VID 

Step 300 : for 1 head + VID with air system 

Step 500 : up to 3 heads + VID with air system 

Step 700 : up to 3 heads + VID with air system and 

enclosure 

Step 700 Noise-Control  : up to 3 heads + VID with active 

electronic system and enclosure  
 

also applicable for 1st generation STeP: 
 

STeP 4 : dedicated for 4 units 

STeP 6 : dedicated for 6 units 

STeP 5 V : Vacuum Surface Testing Platform 

  dedicated for 5 units 

  (primary vacuum pump) 

STeP 5 HV : High Vacuum Surface Testing Platform 

  dedicated for 5 units 

  (primary & secondary vacuum pumps) 
 

it is also applicable for previous CPX/OPX Platform: 
 

CPX Compact Platform (similar to STeP 4) 
OPX Open Platform (similar to STeP 6) 

 

TTX 
Table Top 

also applicable for Table Top Platform first generation 
 

UNHT 

Ultra Nanoindentation Tester (measuring head) 
applicable for: 

UNHT  : 1st generation 

UNHT3  : new generation 

UNHT3 HTV : High Temperature new generation 

UNHT3 V : Vacuum prepared new generation 

 

UNHT Bio 
Anton Paar Bioindenter (measuring head) 
also applicable for UNHT3 new generation 

 

VID optical video microscope (imaging head)  

Welast elastic reverse deformation work of indentation N.m 

Wplast plastic deformation work of indentation N.m 

Wtotal total mechanical work of indentation N.m 

ηIT elastic part of indentation work % 

 
INFORMATION: 
 

1 N/mm2 = 1 MPa 
 

1 J = 1 N.m 
 

1 Vickers = 1 kgf/mm2 
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2 MANAGING THE INSTRUMENT 

2.1 HARDWARE CONFIGURATION 

INFORMATION: The tabs/features which are common for the Scratch and 
Indentation instruments are described in the Common Scratch & Indentation 

reference guide in section Managing the instrument / Hardware 
configuration / Instrument configuration (common tabs). 

 
To reach the following window (Fig.1) and to validate/save the current settings of its 
tabs, refer to the same document and section previously mentioned. 
 

 

2.1.1 MY CONFIGURATION TAB 

 
 

Fig.1 Instrument - Hardware configuration window with tabs 

 
 

2.1.1.1 Common (UNHT/NHT/MHT) 

 
This feature is inactive; it is reserved for future use. 

 

2.1.1.2 UNHT 

 
This inactive box is automatically checked to activate the 
(standard) Sinus hardware present on the UNHT. 

 

 

Select a following radio button: 
 

<No heating> To perform ambient measurements. 
Or 

<Heating stage> To perform measurements under elevated 
temperature with optional Peltier (100 °C) 

or 200 °C Heating Module; see 
section 3.11. 

Or 
 

<High temperature> To perform measurements under high 
temperature with STeP 5 HV - UNHT HTV. 

 

2.1.1.3 NHT 

 

Although it is possible to perform the measurements on NHT under 
elevated temperature, it is not recommended, because the 

thermal drift of the instrument can be too high. Therefore, it is 
advised to keep this box unchecked  to perform measurements at 
ambient temperature. 
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This box should be checked to activate the optional Sinus 
hardware present on the NHT; the corresponding software 

features become active. 
If this option is not present, this box should be unchecked. 

 
2.1.1.4 MHT 

 
In almost all cases this box should be unchecked. 
(It is only checked if the head is equipped with an Electronic 
bridge, which concerns only a few previous special MHT versions.) 

 
To perform measurements under elevated temperature with 
optional Peltier (100 °C) or 200 °C or 450 °C Heating Module, 

check this box and see section 3.11. 
Uncheck (default) to perform measurements at ambient 

temperature. 

 

2.1.2 VERIFICATION TAB 

This tab allows setting parameters used for verifying the instrument and also 
defining a reminder when verifying the instrument. 

INFORMATION: The verification only works with instrument equipped with Sinus 
mode option. 

 
See section 2.2 for the instrument verification procedure and results. 
 

 
 

Fig.2 Verification tab with (advised) default parameter settings for NHT 

 
Passive graph (on the right side): 

It shows the F/S2 curve which is constant with fused silica (SiO2) sample. The 
green frame zone of the graph is the tolerance of this constant.  
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h low limit, F/S2 min and F/S2 max fields: 
To change the 3 default values corresponding to the instrument measuring head 

(see the following <Reset to defaults> button), that are used to compute the 
verification results (section 2.2). 

IMPORTANT: Only an expert user may change these 3 default values. 
 

Reminder box: 
To remind the user to perform a new verification procedure (section 2.2) on the 
instrument measuring head, check this box (default) and set its following field. 

Uncheck to not remind. 
 

Reminder field: 
To set the number of days (default 90) after which the user should be reminded 
(if the previous box is checked) → After the defined number of days has elapsed, 

before starting a new measurement (Indentation  icon on toolbar, section 3.6), 

a Confirmation window recommends the user to perform again the verification 

procedure (section 2.2). 
 

 
 

<Yes> button:  
To continue the current measurement(s). 

 
<No> button: 

To cancel the current measurement(s). 

 
<Reset to default> button: 

To set automatic default (advised) values for each parameter of the instrument 
current measuring head. 
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2.1.3 'RANGES' TAB(S) 

IMPORTANT: Refer to the Common Scratch & Indentation software reference 

guide and carefully read section Managing the instrument / Hardware 
configuration / 'Ranges' tab(s). 
 

 
2.1.3.1 UNHT 'Ranges' tabs 

UNHT has the 3 following 'Ranges' tabs. 

 

 
 

Fig.3 UNHT Indenter ranges tab 
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Fig.4 UNHT Dynamic ranges tab 

 

 

 
 

Fig.5 UNHT Reference Ranges tab 

 
 

 
 
 

 
 

 
 

 
1) Select (2 times max.) the right cursor to display (fully) the 2 last tabs or select the left 

cursor to display (again) the 2 first tabs. 

  

See UNHT & NHT Dynamic calibration (Sinus), 

p. 19 

1) 
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2.1.3.2 NHT 'Ranges' tabs 

NHT has 2 'Ranges' tabs. 

 

 
 

Fig.6 NHT Ranges tab 

 

 
 

Fig.7 NHT Dynamic ranges tab 

 
 
 

 
 

 
 
1) Select (1 time max.) the right cursor to display (fully) the last tab or select the left to 

display (again) the first tab 

  

See NHT Digital bridge, 

p. 18 

See UNHT & NHT Dynamic 

calibration (Sinus), p. 19 

1) 
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NHT Digital bridge 

To properly use the instrument, the auto tuning of the Dz sensor bridge should be 
performed once during the instrument (control unit) installation. However this 
tuning can be performed again if needed. The procedure is an automatic tuning of 

the Dz bridge (electronic adjustment process). 
 

In Ranges tab (Fig.6), click  

 

The Dz Bridge tuning window appears (Fig.8). 
 

INFORMATION:  a special area used for factory 

setting (not dedicated for the user) is available but an access code is needed to use 

it. 
 

Click  to start the automatic tuning process. 

 

The tuning is processing: the software scans (progression bar % increases) the 

entire Dz sensor bridge and adjusts the limits for a quicker detection. 
 

The previous limits saved in the software are displayed. 
 

 
Fig.8 Scanning completed 

 

End of the tuning: The scanning is completed (100 %) and the New limits calculated 
by the software are displayed. 
 

Click  to validate the New limits (overwrite the previous ones) in the 

software. 
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In the Ranges tab (Fig.6), 
 

 

 
 

 
the new Dz bridge limits appear. 

INFORMATION: If the tuning is performed again (after 

the first time), the New limits should be the same or 
almost the same as the previous limits - only a few % of 
difference should be displayed. 

 
 

in Fig.8 

 
UNHT & NHT Dynamic calibration (Sinus) 

The Dynamic coefficients fields and <Calibrate> button are located in the Dynamic 

ranges tab of the UNHT (Fig.4) and NHT (Fig.7). 
 
The dynamic calibration is only available with the optional Sinus mode/generator. 

 
INFORMATION:  

 

With NHT 
 

If  is inactive, it means the optional Sinus hardware is not present 

(section 2.1.1.3) and this calibration cannot be performed. 

 

 
 

Fig.9 Dynamic coefficients (e.g. UNHT) 

 

Before running any Sinus measurements, including the indenter Sinus calibration, 
this dynamic calibration should be performed: 
 

- At the instrument installation. 

- Each time a new indenter is used. 
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First it is recommended that an ADO has been successfully  performed 

(section 3.4.2). 
 

Then click  to open the following UNHT or NHT Head Dynamic 

Calibration window (Fig.10). 

 
If the procedure was already performed once before, the window contains the 
curves and values of the previous calibration. 

 

 
Fig.10 Head Dynamic Calibration window (e.g. NHT) 

 

 

 

To load a dynamic calibration from a .DCF file format. 

 
To save the current dynamic calibration into a .DCF file 

format. 

 
To export the current dynamic calibration into a .TXT file 

format. 

 

 

To stop the dynamic calibration when it is proceeding. 

 
 

 

Only for NHT 
 

To set another indenter position for the calibration; 

for advanced user only. 

 
To start the semi-automatic dynamic calibration 
procedure, which is described below. 
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If no ADO or non-successful 

ADO has been performed 

 (section 3.4.2), it is 
recommended to perform 

one by clicking <Yes> 
button (section 3.4.4). 

INFORMATION: Having a successful ADO  prior starting the dynamic calibration 

allows defining the indenter position to perform this calibration in the same 

condition as a measurement (that is to say the most correct one possible). 

 
 

 

Click  to 

move the edge of the 

sample under the reference 
and so that the indenter 

cannot touch the sample 
(UNHT reference, NHT 
reference ring), as shown 

on the corresponding 
image. 

 

Then click . 

 
 

 

For UNHT 
 

This additional ADO 
parameters window with 
the same previous 

successful ADO parameters 
appears and is used to 

approach the UNHT 
reference to the sample 

surface and also to pre-
approach the indenter. 
 

Click . 

Then in the Head Dynamic Calibration window (Fig.10): 
 

The 4 following circle statuses (on window top left side) blinks green one after the 
other (from top to bottom); wait. 
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 (The reference approaches for UNHT and) the 

indenter pre-approaches. 

 Free oscillation analysis to determine the mobile 
mass and the damping coefficient: the curves in 
the 2 upper graph areas are displayed/updated. 

 Forced oscillation analysis on a broad frequency 

range. It will compute the dynamic head response 
(phase and gain): the frequency value increases 
and the measurement curves are displayed in real 

time in the Results bottom graph area. 

 When the phase calibration measurement is 
completed, the indenter (and reference for UNHT) 
are retracted. 

 
When this button becomes again active , the 
calibration is completed as follows: 

 

The new calibration values are updated on the 
top right corner of the window and all new 

curves are displayed accordingly in all graph 
areas. 
 

Click  (approve). 

In the Dynamic ranges tab (Fig.9): 
 

 

All Dynamic coefficients field values are 
automatically updated with the 3 new values 

(approved) of the previous dynamic calibration. 
 

Click  (validation of these 

new values). 

  

new 
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2.1.3.3 MHT Ranges tab 

MHT has only one Ranges tab. 

 

 
 

Fig.11 MHT Ranges tab 
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2.1.4 INSTRUMENT ADJUSTMENT TAB 

 
 

 

INFORMATION: All Sinus parameters in PID 
control area are inactive with: 
 

• MHT 
 

• NHT, if Hardware generator box is 
unchecked in My configuration tab 

(section 2.1.1.3) 

 

2.1.4.1 PID control area 

It is not recommended to modify the factory parameter field values, which 
guarantee a good depth or load control during the indentation measurement on the 
majority of materials. If necessary, click <Restore factory settings> button to 

restore the values. 
 

 
 

 
  

Approach Depth Load 

Sinus 
amplitude 

Sinus 
force 

Sinus 
depth 

Section 

2.1.4.1 

Section 

2.1.4.2 
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Fig.12 Control loop schematic description 

 
INFORMATION: In measurement cycle the approach phase and retract phase are 

depth controlled. 
 

 
2.1.4.2 Cancel drift area (stabilization) 

During the automatic ADO process (section 3.4.4.2) and during the indentation 

measurement process (section 3.8), a Stabilization step  (in Status 
area) is performed to wait for an acceptable thermal drift before performing an 
indentation. 

 

 

The stabilization ends: 
 

When the thermal drift is under the set 
Threshold field value, 

 

OR 
 

after the elapsed set TimeOut field value. 
 

Click <Restore factory settings> button to restore 

the factory values. 

  

Pause 

Unloading 

 rate 
Loading 

   rate 

Retract 

   speed Approach 

speed 

Time 

Load/depth 

Depth control Depth control Depth or load control 
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2.2 INSTRUMENT VERIFICATION 

INFORMATION: The instrument verification is only possible with the Sinus mode, 

available with all UNHT and optional with NHT (the Hardware generator box should 
be check in section 2.1.1.3). 

 
Select "Instrument > Instrument verification…" from menu bar. 
 

 
Fig.13 Verification window - E.g. good NHT verification results 

 

2.2.1 RESULTS 

The parameters used to compute each verification result are defined in section 2.1.2  
 

Verification history list 
 

To select (highlight) one of the verification measurement (files are created after 
each automatic measurement → see following <Proceed to verification> button), in 

order to see its results in the following F/S2 graph and in Results area.  
The current/last verification is the one at the bottom of the list. 

 
F/S2 graph 
 

There are 3 ways to display the verification results in the graph, 
 

Raw curve  icon:   

 

OR 
 

Standard deviation  icon:  See Fig.13 
 

OR 

Boxplots  icon:   
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Results area 
 

 
 

Fig.14 E.g. Bad NHT verification results  
 

Verification date: The date and time when the verification measurement has been 
performed are displayed and correspond to the selected measurement in the 

Verification history list, except if the file is renamed (it is possible but not advised; 
see following <Proceed to verification> button to access to the files). 
 

Status: If the verification results are good (Fig.13), a green tick appears. If the 

verification results are bad, a red cross appears (Fig.14). 
 

Indenter: The defined details of the indenter which has been used for the 

verification measurement are displayed.   
 

Results table: The detailed values are summarized in this table. The bad Verified 
value(s) is highlighted in red and the good one(s) in green. As soon as one value is 

highlighted in red, the previous Status displays a red cross (bad result).  
 

IMPORTANT: In case of a current bad verification results (the last measurement 

selected at the bottom of the list), it means there is a problem on the instrument. 
The problem should be solved in order to perform a new verification procedure until 

it is good. The problem(s) could be: The Indenter is not properly mounted on the 
measuring head (indenter holder), the indenter is dirty, worn out, the sample is not 
properly mounted (sample holder), the measuring head has a trouble or is bad 

calibrated (Ranges hardware coefficients are wrong)... 
 

 

Fig.15 E.g Current (last) verification is good 
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File area 
 

<Open files in explorer> button: 
To open the software dedicated folder location where each verification 

measurement file is stored. 
 

 
 
2.2.2 PROCEDURE 

It is advised to verify the measuring head at least every 90 days (section 2.1.2 
under Reminder field). 

 
 

Prior to using the following buttons, the provided fused silica (SiO2) sample 

should be properly mounted on the instrument sample holder; refer the 
corresponding Indentation head user manual or reference guide. 

 

1- Define verification location area 

 

<Position control…> button: 
To open the Position control window1 in order to target a suitable location on 

the fused silica (SiO2) sample, where to start the verification measurement 
(see following button).  

 

2- Proceed verification area 
 
<Proceed to verification > button: 

To start the automatic measurement for the verification. The measurement file 
is created in the software and appears in the Verification history list. 

 
 
 
1 Refer to the Common Scratch & Indentation software reference guide in section 

Managing the instrument / Position control. 
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2.3 OPTIONS/PREFERENCES/ISO NOMENCLATURE 

To display ISO 14577 nomenclature 

Select "File > Options…" from menu bar and then Preferences tab. 
 

 
Fig.16 Preferences tab in Options window 

 
 

INFORMATION: 
The feature below is 
applicable with Marten 

hardness, Tangent 
and e.g. Oliver & 

Pharr analysis 
methods (section 

4.5). 
 
 
 

Check 
to display the analysis 

results in ISO 14577 
format (Fig.17). 

 
 

Fig.17 ISO 14577 nomenclature 

In the analysis result area (Fig.84) the Main 
results and Additional results values are 
displayed in ISO 14577 format. 

 
E.g. HIT 0.01/30/10/30 ; 
 

see the details of the nomenclature in 
accordance with the 
ISO 14577-1:2002 standard. 

See also: 

• section 1.2.6 (Abbreviations & symbols) 
• section 6 (Software formulas) 

 
INFORMATION:  unchecked in Fig.16 is the default format. 
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2.4 CALIBRATION 

INFORMATION: The Distance and Center tabs which are common for the Scratch 

and Indentation instruments are described in the Common Scratch & Indentation 
software reference guide in section Managing the instrument / Calibration 

(common tabs). 
 
To reach the following window (Fig.18) and to validate/save the current settings of 

its tabs, refer to the same document and section previously mentioned. 
 

 
 

Fig.18 Instrument (e.g. Step - UNHT) - Calibration window with tabs 

 

See the following sections which described the detailed parameters of each tab 
concerning only the Indentation heads. 
 

INFORMATION: Sensor ranges and Default values tabs are available only with 
UNHT/Bio. Platform tab is not available for TTX-NHT. 
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2.4.1 SENSOR RANGES TAB (UNHT/BIO) 

 
 
 

Fig.19 E.g. Step - UNHT with fine ranges 

 
INFORMATION: For UNHT Bio there is no reference. Therefore the + Reference 
load range radio buttons are inactive. 

The UNHT Bio + Indenter load range and + Depth range values are different than 
the UNHT. 

 

 
 
 

This tab is also available in the UNHT/Bio Hardware parameters window; for the 
detailed descriptions, see respectively sections 3.7.6.3 and 3.7.6.4. 
  

(Same parameters for TTX) 
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2.4.2 PLATFORM TAB (NOT FOR TTX-NHT) 

INFORMATION: This tab is not available with TTX-NHT (as it does not have a 

motorized Z table). 
 

 
Fig.20 E.g. Step - MHT 

 

Table Z retraction field: 
 

NOTICE 
Risk of collision and damage 

To set a value at which the motorized Z table automatically returns (lowered) 
to its rest position after it has been raised (e.g. when the position control is 
closed after a focus adjustment, or after a measurement…) 

To save time, the field value can be adjusted according to the height of sample 
used. If the sample is not flat and/or tilted, set enough margins in order that 

the sample does not enter in collision with the indenter during lateral 
displacements (e.g. between each indentation in a matrix). 

 

INFORMATION: 1 mm is the initial value and 0.5 mm is the min. value. The unit 
of the field is defined in the options (e.g. mm). 

 

Auto return to safe position box: 
To automatically return to the safe position at the end of each measurement, 

check this box → The motorized tables/sample move to the extreme right front 
position. This is the same position as clicking  on the main toolbar. 

Uncheck to stay where the sample was before running the measurement(s). 
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2.4.3 DEFAULT VALUES TAB (UNHT/BIO) 

 
Fig.21 E.g. Step - UNHT with both default values 

 

 
Fig.22 Step - UNHT Bio with indenter default value 

 

Indenter parameter area 
 

Default pre-approach field: 

To define a value for the indenter pre-approach used in the 3 presets of the 
hardware parameters (section 3.7.6.11). 

 
Reference parameter area 
 

Default pre-approach field: 
To define a value for the reference pre-approach used in the 3 presets of the 

hardware parameters (section 3.7.6.11). 
INFORMATION: For UNHT Bio there is no reference. Therefore the related Default 

pre-approach field is inactive. 
 
<Reset to default> button: 

To set the default values in the fields → 
UNHT:  Indenter 10 % and reference 40 % (Fig.21) 

UNHT Bio: Indenter 5 % (Fig.22) 
  

(Same parameters for TTX) 

(Same parameters for TTX) 
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2.5 MANAGING THE INDENTERS 

The indenter which is mounted on the measuring head should be created and/or 

selected. 
 

 

Select "Instrument > Indenters… " 

from menu bar. 

Edit indenters 

 
Fig.23 Edit indenter windows 

 

 
To create a new indenter in the Configured indenters 

list. 

 
Fig.24 Define a new indenter window 

Select (double click) the 
type of the indenter which is 

used (section 2.5.1). 

 
To modify the selected (highlighted) indenter in the 
Configured indenters list (section 2.5.1). 

List 
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Before running a measurement 
 

IMPORTANT: If there are several Configured 

indenters in the list, do not forget to select the 
Indenter in use with the last calibration date if 

available (the calibration date in section 2.5.3, is 
displayed next to the indenter serial number). 

- To keep the old indenter calibration, create a new indenter – recommended. 
- To overwrite an indenter calibration, edit the existing indenter (section 2.5.2). 

 
To remove the selected (highlighted) indenter from 

the Configured indenters list. 

 Not applicable. 

Import/export 

 To export the selected (highlighted) indenter in the 
Configured indenters list (saved as an indenter file). 

This window allows: 
 

  

Then click  

 

- Choosing a location 
where to save the 
indenter file. 

 

- Modifying the default File 
name corresponding to 

the selected indenter. 
 

- Changing of the default 
V6 .IND file format. 

 

  

 
To import an indenter (which was exported) in the 
Configured indenters list. 

A similar as for the export above, a window allows choosing a location where to 

open an indenter file with .IND format. 
 

Then select the file and click  or double click on the file to open it. 
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Indenter file (.IND) info 

The exported/imported indenter .IND file format includes only the result of the 
calibration: Only the average point (of the 5 indents kept or excluded from the 
.MIT file) for each load. Therefore it should not be confuse with the indenter 

calibration .MIT file format which includes all indentation measurements. 
 
Indenter in results 

Later, after each measurement, the indenter in use appears: 
 

• on the bottom left side of the analysis results window; see from section 4.12. 
 

 
 

• in the printed/PDF report (from page 2 and depending on the report option 
configuration); refer to the Common Scratch & Indentation software 
reference guide in sections: 

 

◦ Customizing options / Document models tab 
◦ Printing/PDF Document Reports 
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2.5.1 INDENTER PROPERTIES WINDOW 

 or  is clicked in the Edit indenter windows (Fig.23). 

 

 
Fig.25 Indenter properties window with no calibration/date 

 

*  

 

This field should be filled in. 

* 

 

 
Adapt (set) the material and values of all other 
fields which will be used for the measurement 

analysis results. 
 

INFORMATION: The initial Beta value 
corresponds to the indenter type selected in 

Define a new indenter window (Fig.24). 
 

INFORMATION: The initial Poisson’s ratio + 
Young’s modulus values correspond to the 

diamond material. 

  

*   *  

If Spherical or Flat Punch indenter type is 
selected in Define a new indenter window 
(Fig.24) these 2 additional fields appear. 

* indicated on the indenter provided certificate 

 

 To (re)calibrate the indenter (section 2.5.2). 

  

INFORMATION: If the indenter is not 

calibrated, its geometry is approximated to a 

perfect shape tip. 

For Berkovich and Vickers indenters, the 

theoretical function Ap = 24.5 hc
2 is used to 

approximate the area function. 
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2.5.2 INDENTER CALIBRATION (QUASISTATIC/SINUS) 

 is clicked in the Indenter properties window (Fig.25). 

The calibration procedure starts. 
 

2.5.2.1 Measuring a matrix of indentations 

INFORMATION: Use a certified Fused silica sample with UNHT and NHT, or a 
certified BK7 sample with MHT. 
 

INFORMATION: Sinus calibration is not available (  
inactive) for MHT and UNHT Bio, and NHT without the optional sinus 

module/generator (section 2.1.1.3). 
 

 
Fig.26 Choose a calibration procedure 

 

Select for a quasistatic calibration 

OR  for a Sinus calibration and click . 

 
For MHT only  

 

If the ADO is not yet successful  (section 3.4.2): 
 

 

Click <OK> button to start a 

new ADO. 
IMPORTANT: The fine Dz 

range <100 µm> radio 
button should be selected in 
ADO parameters window 

(section 3.4.7.1). 
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Otherwise if the current ADO is successful  (section 3.4.2): 
 

 

If the sample has already been 
moved with a min. displacement 
from the current ADO indent 

(similar sample topography), click 
<No> button to keep this current 

ADO. 
OR 

If the sample has not been moved 

or has been moved too much from 
the current ADO indent (sample 

topography may vary), click <Yes> 
button to start a new ADO 
IMPORTANT: The fine Dz range 

<100 µm> radio button should be 
selected in ADO parameters window 

(section 3.4.7.1). 

 
Fig.27 Calibration parameters (e.g. quasistatic UNHT) 

 

 

Select  and set the Plane strain 

modulus (E*) field value noted on the 
certificate provided with the certified 

used sample. Then press <Enter> key. 

OR 
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Select and set the 
corresponding (theoretical) values in 

both fields. 

 

 

Select a quasistatic calibration mode. 
 

INFORMATION: The number of the 
indentations and loads for the matrix of 

measurements are different for each 
measuring head. 

OR 
 

 
 

E.g. Sinus for UNHT 

The Sinus mode is selected, set  

which is the number of indentations for the 

matrix single row. INFORMATION:  Advised 
value is 5. 
 

INFORMATION: Automatic Constant Strain 

Rate (CSR Sinus mN), load (mN) and 
frequency (Hz) values (to perform later each 
calibration measurement) are different for 

NHT. 

Click . 
 

 

 

Click . 
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Wait time 

 
 

Set a delayed starting 
 

 

If necessary, to select another measurement date (than today) 
in the calendar. If necessary, click  to go to the next month 
(and then click  to come back). 

  

To set the hour and minutes of the selected date when the 

matrix of measurements should start if the below button is 
clicked. 

 To wait for the date and time previously set (above), before 

starting the automatic matrix of measurements: 
 

The remaining waiting time until the measurements start is 
displayed  

OR 
 

Direct starting 
 

 To start the automatic matrix of measurements (even if 

 has been clicked). 

Then: 
 

- Only for UNHT/Bio or NHT, first the ADO in progress window appears (see 

descriptions from Fig.38). For these instruments, anyway an ADO is 
automatically performed before running the calibration matrix of 
measurements. There is no need to set any ADO parameters, they are 

automatic (transparent) and optimized for this calibration. 
 

- Just after, Indentation running… window (same as Fig.76) appears; wait for all 

automatic matrix of measurements are performed. Once the last measurement 
is completed, the following window appears and allows: 
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Then click . 

- Choosing a location 
where to save the 

calibration measurement 
file. 

 

- Modification of the 
default File name 

calibrated indenter with 
the date when the 1st 
calibration measurement 

has been started. 
The default file format is 

.MIT 

Then, the following window appears. 
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Contact area determination 

E.g. with quasistatic, they are batches of 5 indent curves measured at different 
indentation loads: each 5 indents are performed at the same load. For all these 
indents/curves, e.g. 12 loads x 5 indents = 60 indents/curves, first the contact 

points should be refined if necessary and then only the relevant indents should be 
kept → the bad indents should be excluded from the calibration results. 

 
With Sinus it is similar, exception: The number of indents measured depends on 

the previous setting (e.g. 5 indents advised) and there are no loads to select 
e.g. = totally 5 indents/curves. 
 

 
Fig.28 E.g. Indent #3/12 is excluded (non-relevant) 

 

 (next)  (previous) 

 

 

inactive 

To select next or previous load batch. 
 
 

For Sinus, no load to select. 

Total of different loads 

Batch of current load  



 

H70IB103EN-C 44 

 
(initial) 

To show all curves of the selected load batch. 
 

Place the mouse cursor on one indent of the batch to 
highlight the corresponding curve. 

 
To show one curve of the selected load batch. 
 

Place the mouse cursor on one indent of the batch to 

display it. 

 

Procedure 

 
To verify and refine if necessary the contact point for 

 

all indent curves of the current load batch; see 
sections 4.1.1.1 and 4.1.1.2. 

 
 
 

  
→   

 

e.g. see Fig.28 

Then, 
Keep only the relevant indents 

Uncheck to exclude (from the calibration results; see 
Validation of the results, p. 46) each non-relevant 

indent/bad curve, which becomes gray. 
 

If necessary, check it again to re-include it 
(relevant). 

With quasistatic mode, repeat the Procedure above for each load (  e.g. 12 

loads , so totally 60 (5x 12) contact points and curves should be verified). 
 
 

To display the indent curves of the current load ( / ) on the graph 
 

 (initial) F vs. h (combined curves), or 

 F vs. time (force curves), or 

 h vs. time (depth curves) 

OR 
 

 To display the projected area vs. contact depth: 

 

Only with quasistatic, the indents 

of all loads are represented with 
circles on the graph. Only the 
relevant indents are displayed in 

color. 
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 To display graph logarithm scales (selected). 

 To display only the relevant indents of the current load; see 
Keep only the relevant indents, p. 44: 
 

The non-relevant (  unchecked) indents in gray are 
hidden from the graph. 

 To zoom the indent curves on the graph; for the descriptions, 

refer to the Common Scratch & Indentation software 
reference guide in section Measurement Documents in 
Curve view / Document window interface / Graph area 

tools / Zoom. 

When all contact points and curves are verified, click : 
 

IMPORTANT: Any modifications (contact points and exclusion of non-relevant 
indents/bad curves) are automatically saved on the current calibration 
measurement file .MIT (which were saved after the matrix of measurements or 

loaded). 
 

 
 
The following window appears. 
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Validation of the results 

According to the previous Contact area determination, p. 43, the red curve fits on 
the crosses displayed on the graph of the window Fig.29: 
 

E.g. with a quasistatic calibration, each cross corresponds to the average of the 
relevant (kept) indents for each load (e.g. 12 loads = 12 crosses). 

 

With a sinus calibration, each cross corresponds to the average of the relevant 

(kept) indents of the sinus analysis at the corresponding contact depth (more 
crosses). 

 

 
Fig.29 Curve results of indenter contact area (Ap) vs. contact depth (hc) 

 
Select  to display graph logarithm scales, 
OR select (initial)  to display graph linear scales. 

 

Verify the curve and if necessary click  and modify the Contact area 

determination, p. 43. 
 

When the curve is suitable, click  and see sections: 
 

• 2.5.3 (Calibration date) 
• 2.5.4 (Fit methods AP(hc) of the calibration) 
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2.5.2.2 Loading indentations from file 

This procedure is similar than for Measuring a matrix of indentations described in 

section 2.5.2.1, exceptions: 
 

- There are no parts related to perform measurements. 

 
- Select  OR  in Fig.26 (chose a 

calibration procedure in the Step 1 window). 
 

- The following window appears and allows: 
 

 

- Choosing a location 

where to open a 
calibration file with 
.MIT format. 

 

- Then select the file 

and click  or 

double click on the file 

to open it. 
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2.5.3 CALIBRATION DATE 

 is clicked after a calibration (Fig.29) or  is clicked in the Edit 

indenter windows (Fig.23) for an indenter already calibrated. 

 
The Curve results of indenter contact area (Ap) vs. contact depth (hc) from Fig.29 is 

reported on the graph of the window below. 
 

 
Fig.30 Indenter properties window (with calibration/date) 

 

 

 
The displayed indenter calibration date always corresponds to the 

date when the last calibration measurement (weakest force) of the 
matrix was ended. 
 

This date is also displayed next to the serial number of the indenter 
in the Edit indenter windows (Fig.23); 
 

e.g. Berkovich [B-Q 03] (25.07.2014) 
 
INFORMATION: The date format depends on the acquisition system 

setting; e.g. could be with this different format 25/07/2014. 

  

Indenter is calibrated 
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2.5.4 FIT METHODS AP(hC) OF THE CALIBRATION 

 is clicked after a calibration (Fig.29) or  is clicked in the Edit 

indenter windows (Fig.23) for an indenter already calibrated. 

 
The Curve results of indenter contact area (Ap) vs. contact depth from Fig.29 is 

reported on the graph of the window below. 
 

 
Fig.31 Indenter properties window Ap(hc) curve 

 

Graph scale display modes 
 

Also applicable in the following Edit Fit Method window (Fig.32). 
 

 
To display graph linear scales, in order to focus on the 
highest indentation depths: red and blue part of the curve 
(e.g. in Fig.31). 

OR 
 

 
To display graph logarithm scales, in order to focus on the 
lowest indentation depths: green and red parts of the 
curve (e.g. in the Fig.32.) 

 

Part of the curve in blue (Fig.31) 
 

Theoretical function (Ap=24.5 hc 2 for Berkovich and Vickers indenters, 
Ap=πhc(2R-h) for a sphere) with a shift in Y (∆Y) to ensure the continuity on the last 

cross (highest depth) of the calibration. 
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Part of the curve in green (Fig.32) 
 

For Oliver & Pharr fit methods: sphere equation passing by the 1st cross (lowest 
depth) of the calibration. 
 

For BSpline: spline equation passing by (0;0) and having the same tangent in (0;0) 

than the sphere equation passing by the 1st cross (lowest depth) of the calibration. 
 

Part of the curve in red (Fig.31 and Fig.32) 
 

Click  to open the following Edit Fit Method window, which 

allows selection of a method to compute a best fit for the contact area function. 
 

The default fit method is the . If necessary select another fit method 
either a ,  or a  fit. 
 

For Oliver and Pharr or Polynomial fit methods, the number of the computed 
coefficients should be adapted in the corresponding field, respectively 

 or . 

 

 
Fig.32 Edit Fit Method window 

 

 
 
Ap = f(hc ) curve, 
 

e.g. in  scale  

 

 
 

 
 
 

BSpline Interpolation 
Linear Interpolation 
 
 

Oliver & Pharr  
 
 

 
 
 

 
 

Polynomial fit 

 
 
 

The following example describes the way to find the best fit with Oliver & Pharr fit 

method. In an ideal case the function should be a line passing by each cross  
(e.g. 12 crosses). 
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The first term hc
 2, the lead term, is by default to 24.5 (coefficient for a Berkovich or 

Vickers indenter). 
 

 
 
 

If a low  (e.g. 0) is used, the fit obtained is not good for some of the 

lowest indentation depths. 
 

 
 
 

E.g. 6 fractional terms gives the best fit. 
 

 
 

 
 
 

For Oliver and Pharr or Polynomial fit methods, each parameter for the Ap fit can be  
 

manually set by clicking : E.g.  

 

(Re)click  for each filed which should be automatically (re)calculated by the 

software. 
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2.6 UNHT APPROACH MONITOR WINDOW (.INI FILE MANAGEMENT) 

IMPORTANT: Be careful, bad modifications in the UNHT.INI file can have a direct 

influence on the UNHT behavior/measurements. Therefore in the file Notepad, edit 
only the lines (highlighted in gray) which are described below and exactly as they 

are typed (spelling is considered/case sensitive). 
 

INFORMATION: ';' in front of each single line of the INI file allows comments. 
 
INI file activation 

To activate the INI file management directly from the software. 
 

 

From the Windows® 
taskbar select: 
 

 → 
 

 → 
 

 → 
 

 → 
 

  

 

To open the UNHT.INI 
file in the Windows®  

Notepad: 
 

- Right click on it and 
select open in the 

context menu 
 

   
 

- Double click on it. 

 

In the Notepad, at the 
section [Extra], edit 

ReloadIni to = 1 : 
 

[Extra] 
ReloadIni = 1 

 

Save the file and close 

the Notepad. 
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Then restart the Indentation Software (this should be done only once): 
 

Select "File > Exit" from menu bar or click  on the right top of the main 

window and start again the software by double clicking  on the acquisition 

system desktop. 
 

Now the .INI file appears in the "Instrument" menu bar. 

 
 
UNHT approach monitor window 

To hide or display later (during ADO process, measurements…) the UNHT Approach 
Monitor window, see the following descriptions. 
 

 
Fig.33 UNHT Approach Monitor window 
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Thanks to the INI file activation, 
p. 52: 
 

Select "Instrument > .INI file 
> Edit.INI file" from menu bar 
to open the Notepad .INI file. 

 

The UNHT Approach Monitor window 
(Fig.33) can be deactivated (will 

be hidden): 
 

In the Notepad, at the section 

[Monitoring], edit Show to = 0 : 
 

[Monitoring] 
Show = 0 

 

The UNHT Approach Monitor window 

(Fig.33) can be (re) activated (will 
be displayed): 
 

In the Notepad, at the section 
[Monitoring], edit Show to = 1 : 

 

[Monitoring] 
Show = 1 

 

Save the file and close the Notepad. 

 

Do not forget to then select  

"Instrument > .INI file > 
Reload .INI file" from menu bar to 

activate the last .INI file 
modifications (there is no need to 
restart the software). 
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3 TAKING A NEW MEASUREMENT 

3.1 INTRODUCTION 

For detailed manipulations and instructions, refer to each corresponding Indentation 
head user manual or reference guide. 
 

 

3.1.1 WARNING 

IMPORTANT: When installing the sample in a sample holder AND when moving the 

sample/(motorized) tables from the video microscope to the measuring head and 
vice versa, avoid any collision with: 
 

• the measuring head, especially with the indenter/ 
reference (UNHT)/reference ring (NHT)/reference fork (MHT)  

 

• the video microscope optical objectives 
 

 

3.1.2 NOTES FOR GOOD MEASUREMENTS 

For a maximum accuracy, the sample surface should be always perpendicular to the 

indenter axis (sample surface leveled). For some specific applications, a special 
sample holder is required to fulfill this condition. 
 

Each sample should be firmly fixed (clamped, glued for UNHT Bio…) into the sample 
holder → the sample should not slide when it is indented and also when the 

(motorized) tables move. 
 

Each sample and sample holder support surfaces should be clean and dust-free. 
Before performing a measurement (ADO included), the chosen sample surface area 
should be free of previous indents. 
 

The indenter should be clean and not too much worn out. 
 

The sample temperature should remain stable during measurement. 
 

 

3.1.3 GENERALITY 

A new indentation measurement or measurements (matrix of indentations) involve 
a succession of logical steps, such as: 
 

1. Installing the sample  

2. Choosing the sample area for the measurement(s) 

3. Adjusting the depth offset (ADO) 

4. Setting up the configuration/parameters for the measurement(s) 

5. Running the measurement(s) 

6. Analysis of the measurement results 
 
Each of these steps is described in the following sections. 
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3.2 INSTALLING THE SAMPLE 

1. To move the motorized tables to safe position (max. right front table position), 

click  on the toolbar. 
 

2. Install firmly the sample into the sample holder. 
 
 

3.3 CHOOSING THE INDENTATION AREA 

For all information about the Position control window features (management of the 

indenter/video microscope areas, different methods to move with different speed…), 
refer to the Common Scratch & Indentation software reference guide in 
section Managing the instrument / Position control. 

 
IMPORTANT: Do not change the focus once it has been adjusted. To avoid any 

collision, always verify the sample height before moving. 
 

1. To choose the sample measurement area, click  on the toolbar. 

In the Position control window which appears: 

 

2. To move the sample/motorized tables under the video microscope click  . 

The microscope zone should be activated  (under microscope icon), 

otherwise click  . The Video Software window is open, otherwise click 

 . 
 

 For the video microscope module with Step (not with STeP 5): To lower the 

module (if not already at the lowest position) click  . 

 

3. To adjust the focus of the sample surface on the Video screen, move the 

motorized Z table: click to raise /  to lower. 

 

With a TTX-NHT, use the coarse and fine focusing thumbwheels. 
 
4. To move the sample/motorized X-Y tables in order to choose the measurement 

area on the Video screen (under the middle of the crosshair), click  /  / 

 /  . 

 

With a TTX, the non-motorized table(s) should be manually move. 

 
When exiting the Position control window, the motorized table automatically 
retracts. 

 
Then the sample will be automatically moved under the indenter, at the chosen 

measurement area, before starting the ADO procedure (  / ) and then before 

starting the measurement procedure ( ). 
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3.4 ADJUSTING DEPTH OFFSET (ADO) 

3.4.1 AIM 

The ADO is a procedure carried out to correctly setup the depth sensor 
measurement range (offset of the contact point inside the measurement range) for 
the next indentation measurement(s) (from an indenter calibration or a 

measurement type):  
- Because of the unpredictable sample surface topography. 

- To optimize the duration of the measurement(s). 
 

Reasons for which the ADO should be performed: 

- After restarting the software. 
- If the sample surface topography may vary between the measurements. 
- If the measurements are performed on multi-sample where the surface 

topography varies. 
- After changing the sample. 

- After changing the indenter. 
- Only for UNHT, after changing the reference. 

 

 

3.4.2 ADO ICON STATUS 

 
 

An arrow over the ADO icon displayed on toolbar means no or not successful ADO 

has been performed. Therefore a (new) procedure should be started (section 3.4.3). 
 

 
Fig.34 No/Not successful ADO icon 

 

When the last (current) ADO has been successfully performed, a green disk with a 
tick appears over the ADO icon on toolbar. Anyway, for any reasons described in the 

previous section 3.4.1, a new procedure should be started (section 3.4.3). 
 

 
Fig.35 Successful ADO icon 

 

3.4.3 ADO STARTING 

3.4.3.1 Manual 

Before starting the ADO, use the Position control to ensure that the current location  
on the sample surface is free of previous indents and clean; refer to the Common 

Scratch & Indentation software reference guide in section Managing the 
instrument / Position control. 
 

To start the ADO (section 3.4.4), select "Instrument > Adjust depth offset…" 

from menu bar or click ADO  /  icon on toolbar. 
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3.4.3.2 Automatic 

If the current ADO is not successful  (section 3.4.2), it can be started from a 

measurement type. The following window appears to set an offset positon (from 
current position) and the ADO parameters before performing the automatic process. 
 

 
Fig.36 Insert an ADO offset window 

 

Delta X and Delta Y fields: 
To set the ADO relative position values from the 1st point of the matrix.  
IMPORTANT: This location on the sample surface should be free of previous 

indents and clean. 
 

<Edit adjust depth offset parameters> button: 
To set the ADO parameters (section 3.4.4.1). 
 

<OK> button: 
To start the ADO automatic process (section 3.4.4.2). 

 
3.4.3.3 From indenter calibration or matrix measurement types 

The ADO can also be started from: 
- An indenter calibration; for details see section 2.5.2. 

or 
- From a matrix measurement type; for details see sections 3.7.5.8 (Simple 

matrix), 3.7.5.10 (Quick matrix), or 3.7.5.12 (Multi-ADO for  
Advanced matrix 3.7.5.9 or Visual advanced matrix 3.7.5.11) 

 
 
3.4.4 ADO GENERIC PROCEDURE (UP TO 3 WINDOWS) 

The ADO is composed by 2 or 3 windows (depends from where the ADO is started) 

described as follows. 
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3.4.4.1 ADO parameters 1st window 

The Adjust depth offset parameters window allows setting the parameters which are 

used to perform the ADO automatic process.  
 

 
Fig.37 ADO window (e.g. NHT with default presets) 

 
Surface detection parameters area: 

The fields are different depending on the current type of the measuring head; 
they are described in details in sections 3.4.5.1 (UNHT/Bio), 3.4.6.1(NHT) and 

3.4.7.1 (MHT). 
 
"Presets" drop-down menu: 

To select one of the following presets according to the material of the current 
sample. 

 

 
 

"Default" 

For sample with hard material coating. 
"Soft materials" 

For sample with soft material coating. 

"Ultra soft materials" 
For sample with ultra-soft material coating. 

 

<'Apply'>  button: 

To apply the current "Presets" drop-down menu selection → The field values 
previously described are automatically set (updated) accordingly. 

If the material matches with the selection, the parameters are suitable to 
perform a successful ADO. 

 
<OK> button: 

To valid the current settings. And also to run the following automatic process 

(section 3.4.4.2), only if the ADO has been started: 
- Manually (section 3.4.3.1) 

OR 
- From the indenter calibration, only for MHT (section 2.5.2). 
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3.4.4.2 ADO in progress 2nd window 

The Adjust depth offset in progress window is performing the automatic (semi-

automatic for MHT without electronic bridge) process sequences using the 
parameters previously described (section 3.4.4.1) - An indentation is performed. 
 

   
Fig.38 Minimized  or developed Adjust depth offset in progress window 

 
This window features are described as follows. The real-time sequences are different 
depending on the current type of the measuring head; they are detailed in sections 

3.4.5.2 (UNHT/Bio), 3.4.6.2 (NHT) and 3.4.7.2(MHT). 
 

Parameters area 
The parameters which have been set in Adjust depth offset parameters window 
(Fig.37) are summarized. 

 
<Cancel> button: 

If necessary, to stop the process and cancel the ADO → not successful ADO  

icon is displayed (section 3.4.2). Otherwise wait until the end of the process. 

 
+ in More Info area (top of window): 

To develop the window for more information, such as Command, Bridges, 

Additional information and graph areas. 
− in Less Info area to minimize the window (default). 

 
Close window automatically box: 

In order to automatically close the window after the process is completed, check 

this box (default). 
Uncheck this box so that the window is not closed automatically 

→ OK button appears to manually close the window.  
 

 
When the window is closed (Fig.38), the user can verify that the current ADO is 

successful  (section 3.4.2). If not  the procedure should be performed again 

until it is successful. 
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3.4.4.3 Sample displacement after ADO 3rd window 

INFORMATION: This section is not applicable if the ADO has been started from a 

matrix measurement type or from the indenter calibration (also a matrix), because 
the ADO indent is then anyway shifted (part of the matrix - Delta X/Y). 
 

When the ADO in progress window (Fig.38) is closed, the following Sample 
displacement after ADO window appears. 

 
IMPORTANT: To avoid performing the next calibration/measurement indent inside 
the ADO indent (current position), the sample/motorized table(s) position should be 

shifted of a minimum displacement1 (otherwise the sample topography may vary). 
 

 
Fig.39 Sample displacement after ADO window 

 

X motorized table field: 

To set another min. displacement value1 for the motorized X table. 
 

Y motorized table field: 
If necessary, to set a min. displacement value1 for the motorized Y table. 

 

<OK> button: 
To move the motorized table(s) to the position 

values set in the fields described above; wait. 

 
 

<Cancel> button: 
To cancel the displacement (no move). However it is recommended to then use 

the Position control window to move the sample into another suitable location; 
refer to the Common Scratch & Indentation software reference guide in 
section Managing the instrument / Position control. 

 
 

 
 
 

 
1 It depends on the current sample material: Approx. 20 x hm 

Pay attention to the unit (e.g µm in Fig.39), which is defined in the options; refer to the 

Common Scratch & Indentation software reference guide in section Customizing 

options / Preferences tab (units). 
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3.4.5 UNHT/UNHT BIO PARAMETERS AND SEQUENCES 

3.4.5.1 Detailed parameters 

 
Fig.40 UNHT ADO window (e.g. default preset for hard sample) 

 

 
Fig.41 UNHT Bio ADO window (e.g. default preset for hard sample) 

 
INFORMATION: There is no reference with UNHT Bio (Fig.41). Thus the 
corresponding Reference area fields are inactive. 

 
The field values of the applied preset (section 3.4.4.1), if the preset corresponds to 

the type of the sample which is used, are suitable to perform a successful ADO. 
However each following value can be separately adjusted if necessary. 
 

 
Surface detection parameters area 
 

Approach speed field: 
To set the speed at which the indenter/(UNHT) reference approach the sample 
surface. 

  

Section 3.4.4.1 

Section 3.4.4.1 

Section 3.4.4.1 

Section 3.4.4.1 
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Contact force field: 
It is the same parameter as the one described in the hardware parameter 

preferences (section 3.7.6.9), but here it is used during the ADO automatic 
process. 

 

Characterization force field: 
To set the indenter force to be applied for indenting the sample. 

 

Contact stiffness threshold field: 
It is the same parameter as the one described in the hardware parameter 
preferences (section 3.7.6.8), but here it is used during the ADO automatic 

process. 
 

Quick mode box: 
Only available with matrix measurement types (section 3.6). 
To speed-up the ADO automatic process (section 3.4.4.2), check this box; the 

reference stays in contact with the sample and the indenter is not fully retracted 
(moved up) till the end of the matrix. 

Uncheck for standard ADO process. 
 

Indenter area 
 

Pre-approach field: 

To set the indenter pre-approach before the first approach starts (the indenter 

moves up out of its rest position: 100 % which corresponds to the fully extended 
(lowest) position of the actuator displacement). 

 

Reference area (for UNHT) 
 

Pre-approach field: 

Similar description as for the indenter field (described above), exception: It is 
applicable for the reference. 

 

Contact force field: 

Similar description as for the indenter field (described above), exception: It is 
applicable for the reference. 
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3.4.5.2 Detailed sequences 

Reminder: Extra UNHT Approach Monitor window (Fig.42) can be hidden or 

displayed with the UNHT.INI file (section 2.6). 
 

 
Fig.42 Extra UNHT Approach Monitor window 

 
For the description of the window common features, see section 3.4.4.2. Otherwise 

wait for the end of the automatic process (described as follows). 
 

 
Fig.43 UNHT/Bio ADO in progress (extended) window 
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INFORMATION: The following sequences concerning the reference are not 
applicable with UNHT Bio (to be ignored). 

 
The window (Fig.43) real-time 

sequences are described on the left  

The instrument actions are described 

on the right 

 With TTX/Step (not with STeP 5), the 
motorized head/module approaches 
(moves down). 

Command area (extended window) 

Indenter Command (beige) and 
Reference command (blue) progression 

bars has decreased (from 100 %); this 
can be observed in UNHT Approach 

Monitor window (Fig.42) under the same 
(vertical) progression bars. 

The Indenter and Reference retract 

(move up) to the pre-approach values 
(section 3.4.5.1), except +15 % is 

added for the reference. 

Bridges area (extended window) 
Fn Bridge (red), Dz Bridge (green) and 

FnRef Bridge (blue) progression bar has 
fluctuated; this can be observed in UNHT 

Approach Monitor window (Fig.42) under 
the same progression bars. 

The Fn, Dz and FnRef sensor bridges are 
automatically adjusted (could be quick). 

Status area 
Approaching Table Z… (green) square  

blinks. 

The motorized Z table slowly approaches 
(moves up). 

Command area (extended window) 
Reference command (blue) progression 

bar decreases. 

When the sample surface contacts the 
reference, the motorized Z table stops 

and the reference actuator is retracted 
(moved up) by 15 % → The Reference 
returns to its initial pre-approach value 

(section 3.4.5.1). 

Status area 
Approaching reference… (green) square 

blinks. 
 
Command area (extended window) 

Reference command (blue) progression 
bar increases. 

The reference approaches (moves down) 
with the Approach speed (section 

3.4.5.1) until it reaches the Reference 
Contact force (section 3.4.5.1). 
INFORMATION: The reference touches 

~10 % above the Reference pre-
approach value (section 3.4.5.1). 
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Status area 
Approaching with the indenter… (green) 

square blinks. 
 

(extended window) 
Indenter area 

Indenter command (beige) 
progression bar increases. 
Additional information area 

Fn (red) and Dz (green) values are 
displayed. 

Graph area Fn (red) and Dz (green) 
curves are displayed. 

The indenter approaches (moves down) 
with the Approach speed (section 

3.4.5.1) until ... 

Status area 
Contact (brown) square lights. 

... it contacts the sample. 
→ The indenter has either reached the 

Contact stiffness threshold or the Contact 
force (section 3.4.5.1). 

Bridges area 

Dz Bridge (green) progression bar has 
fluctuated; this can be observed in UNHT 
Approach Monitor window (Fig.42) under 

the same progression bar. 

The Dz sensor bridge is adjusted. 

Status area 
Stabilization (brown) square lights and 

the decreasing stabilization time is 
displayed (in sec.). 

Wait for the drift stabilization (cannot be 
set by the user, automatic algorithm). 
 

The indenter position slightly varies 
(indenter is still in contact); this can be 

observed in UNHT Approach Monitor 
window (Fig.42) under Indenter 

command (beige) progression bar. 

Status area 
Sample characterization (brown) square 
lights and its progression bar increases. 

An indentation with the Characterization 
force (section 3.4.5.1) is performed to 
evaluate the sample mechanical 

properties. 
As previously described, the indenter 

position slightly varies. 

Additional information area (extended 
window) 
Sample characterization coefficients are 

displayed. 

The ADO is defined. 
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Status area 
Rising the indenter (green) square 

blinks. 
 

Command area(extended window) 
Indenter Command (beige) and 
Reference Command (blue) progression 

bars decrease. 

The Indenter and Reference retract 
(moving up) to their Pre-approach values 

(section 3.4.5.1). 
 

In case of Quick mode box has been 
checked, the indenter is retracted only 

a little bit and the reference stays in 
position (contact with sample) till the 
end of the matrix of measurements.   

 The motorized Z table retracts (moves 

down) to its rest position. 
 

In case of Quick mode box has been 
checked, the motorized Z table stays 
in position (sample against reference) 

till the end of the matrix of 
measurements. 

 And then with Step (not with STeP 5), 

the motorized head module retracts 
(moves up). 
 

In case of Quick mode box has been 
checked, the motorized head module 

stays in lower position (down) till the 
end of the matrix of measurements. 

 At the end of the process, both indenter 
and reference return (move down) to 

their extended rest positions; this can be 
observed only in UNHT Approach Monitor 

window (Fig.42) under Indenter 
Command (beige) and Reference 
command (blue) vertical progression 

bars (increase to 100 %). 
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3.4.5.3 Summary schematics (with Step) 
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3.4.6 NHT ADO PARAMETERS AND SEQUENCES 

3.4.6.1 Detailed parameters 

 
Fig.44 NHT ADO window (e.g. default preset for hard sample) 

 

The field values of the applied preset (section 3.4.4.1), if the preset corresponds to 

the type of the sample which is used, are suitable to perform a successful ADO. 
However each following value can be separately adjusted if necessary. 
 

 

Surface detection parameters area 
 

Approach speed field: 

To set the speed at which the indenter approaches the sample surface. 
 

Characterization force field: 

To set the indenter force to be applied to indent the sample. 
 

Contact stiffness threshold field: 
It is the same parameter as the one described in the hardware parameter 

preferences (section 3.7.6.8), but here it is used during the ADO automatic 
process. 

 
Quick mode box: 

Only available with matrix measurement types (section 3.6). 

To speed-up the ADO automatic process (section 3.4.4.2), check this box; the 
reference ring stays in contact with the sample and the indenter is not fully 

retracted (moved up) till the end of the matrix. 
Uncheck for standard ADO process. 

  

Section 3.4.4.1 

Section 3.4.4.1 
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3.4.6.2 Detailed sequences 

For the description of the window common features, see section 3.4.4.2. Otherwise 

wait for the end of the automatic process (described as follows). 
 

 
Fig.45 NHT ADO in progress (extended) window 

 

 
The window (Fig.45) real-time sequences 
are described on the left 

The instrument actions are 
described on the right 

 With TTX/Step (not with STeP 5), 

the motorized head/module 
approaches (moves down). 

Status area 

Approaching Table Z… (green) square blinks. 

Then with Step (not with 

STeP 5), the Z motorized table 
approaches (moves up) until the 
sample contacts the reference 

ring. 

Status area 
Approaching with the indenter… (green) square 

blinks. 

The indenter pre-approaches 
(moves down) and ... 

An adjusting bridge pop up appears and its 
progression bar increases. 

... the Dz sensor bridge is 
automatically adjusted a 1st time 
(could be quick). 
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Status area 
Approaching with the indenter… (green) square 

blinks. 
 

(extended window) 
Command area  
Indenter Command (beige) progression bar 

increases. 
Additional information area  

Fn (red) and Dz (green) values are displayed. 
Graph area Fn (red) and Dz (green) curves 
are displayed. 

The indenter approaches (moves 
down) with the Approach speed 

(section 3.4.6.1) until ... 

Status area 

Contact (brown) square lights. 

... it contacts the sample. 

→ The indenter has reached the 
Contact stiffness threshold 

(section 3.4.6.1). 

Status area 
Stabilization (brown) square lights and the 

decreasing stabilization time are displayed (in 
sec.). 

Wait for the drift stabilization 
(cannot be set by the user, 

automatic algorithm). 
(This sequence could be quick.) 

An adjusting bridge pop up appears and its 
progression bar is increasing. 

The Dz sensor bridge is 
automatically adjusted a 2nd time 

(could be quick). 

Status area 
Sample characterization (brown) square lights 

and its progression bar increases. 

An indentation with the 
Characterization force (section 

3.4.6.1) is performed to evaluate 
the sample mechanical 
properties. 

Additional information area (extended window) 

Sample characterization coefficients are 
displayed. 

The ADO is defined. 

 
 

Status area 

Rising the indenter (green) square blinks. 
 

Command area (extended window) 

Indenter Command (beige) progression bar 
decreases. 

The indenter retracts (rises) until 

its top (rest) position (0 %). 
 

In case of Quick mode box has 

been checked, the indenter is 
retracted only a little bit till the 

end of the matrix of 
measurements.   
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 With TTX/Step (not with STeP 5), 
the motorized head/module 

retracts (moves up). 
 

In case of Quick mode box has 
been checked, the motorized 

head/module stays in lower 
position (down) till the end of 
the matrix of measurements 

 Then the Step (not with STeP 5) 

Z motorized table retracts 
(moves down). 

 
In case of Quick mode box has 
been checked, the motorized Z 

table stays in position (sample 
against reference ring) till the 

end of the matrix of 
measurements. 
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3.4.6.3 Summary schematics (with Step) 
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3.4.7 MHT ADO PARAMETERS AND SEQUENCES 

3.4.7.1 Detailed parameters 

 
Fig.46 MHT ADO window (e.g. default preset for hard sample) 

 
The field values of the applied preset (section 3.4.4.1), if the preset corresponds to 

the type of the sample which is used, are suitable to perform a successful ADO. 
However each following value and Dz range can be separately adjusted if necessary. 

 
 

Surface detection parameters area 
 

Approach speed field: 
To set the speed at which the indenter approaches the sample surface. 

 

Contact force field: 
It is the same parameter as the one described in the hardware parameter 

preferences (section 3.7.6.9), but here it is used during the ADO automatic 
process. 

 

Characterization force field: 

To set the indenter force to be applied to indent the sample. 
 

Contact stiffness threshold field: 

It is the same parameter as the one described in the hardware parameter 
preferences (section 3.7.6.8), but here it is used during the ADO automatic 
process. 

 
 

 
 
 
1) Dz range values can be different for old MCT versions. 

Fine1) 

Large1) 
 

Section 3.4.4.1 

Section 3.4.4.1 
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Approach distance area field: 
 

For this parameter, see description in section 3.7.6.7 (hardware parameter 
preferences) under MHT approach distance, p. 126. 

 
Dz range 

Dz range area radio buttons: 
 

IMPORTANT: 
- If the ADO procedure is started from the indenter calibration 

(<Calibrate> button is clicked section 2.5.2), the fine Dz range must be 
selected here (e.g. <100 µm>).Otherwise select a suitable Dz range according 
to the sample used/application; it is recommended to use the fine Dz range 

(e.g. <100 µm>) but if the depth saturates, then select the large Dz range. 
- Later in the hardware parameter preferences (section 3.7.6.6), the Depth range 

radio button which is selected should be the same as the ADO Dz range radio 
button selected here (fine: e.g. <100 µm>) for the current successful ADO. 
Otherwise an error message appears; see section 5.2. 

 
Indenter area 
 

Pre-approach field: 
To set the indenter pre-approach before the first approach starts (the indenter 
moves down out of its rest position: 0 % which corresponds to the fully retracted 

(highest) position of the actuator. 
The min. and recommended value is 10 %. 

  



 

H70IB103EN-C 76 

3.4.7.2 Detailed sequences 

For the description of the window common features, see section 3.4.4.2. Otherwise 

wait for the end of the automatic process (described as follows). 
 

 
Fig.47 MHT ADO in progress (extended) window 

 
The window (Fig.47) real-time sequences 

are described on the left 

The instrument actions are 

described on the right 

Command area (extended window) 
Indenter Command (beige) progression bar 
increases. 

The Indenter pre-approaches 
(moves down) to the value set in 
Pre-approach (section 3.4.7.1). 
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This extra Adjusting Dz range window (Fig.48) 
appears over window Fig.47. 
 

 
 

 
Fig.48 Adjusting Dz range window 

Dz range adjustment 1 

Turn1 the wheel to adjust the first 
DZ range targeted Approach 
distance (section 3.4.7.1) used 

for the next measurement(s) 
performed later: 
 

With the special tool long pin 
(or with the old centering tool, 

or a small Allen key), turn1 the 
wheel to adjust the Dz vertical 
cursor preferably into the 

central green position or into 
any yellow (down: positive 

error from target/up: negative 
error from target). 

 

Then click <OK> button to 
continue (this window Fig.48 is 

closed). 

Status area 
Approaching Table Z… (green) square blinks. 

The motorized Z table 
approaches (moves up) until the 

sample contacts the reference 
fork. 

Status area 
Approaching with the indenter… (green) square 

blinks. 

The indenter approaches (moves 
down) with the Approach speed 

(section 3.4.7.1) until ... 

Status area 
Contact (brown) square lights. 

... it contacts the sample. 
→ The indenter has either 

reached the Contact stiffness 
threshold or the Contact force 

(section 3.4.7.1). 

Status area 
Stabilization (brown) square lights and the 
decreasing stabilization time are displayed (in 

sec.). 

Wait for the drift stabilization 
(cannot be set by the user, 
automatic algorithm). 

 
 

 
 
1 The rotation direction (an arrow) is displayed on the extra window (Fig.48). 

  /  

+ 

− 
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Fig.48 appears again over window Fig.47. 

Dz range adjustment 2 

Adjust the other Dz range; see 
the same instructions as 
previously described in Dz range 

adjustment 1, p. 77. 

Status area 
Sample characterization (brown) square lights 

and its progression bar increases. 
 

Additional information area (extended window) 

Fn (red) and Dz (green) values are displayed. 

An indentation with the 
Characterization force (section 

3.4.7.1) is performed to evaluate 
the sample mechanical 

properties. 

Additional information area (extended window) 
Sample characterization coefficients are 

displayed. 

The ADO is defined. 

 The Z motorized table retracts 
(moves down). 

Status area 
Rising the indenter (green) square blinks. 
 

Command area (extended window) 
Indenter Command (beige) progression bar 

decreases. 

The indenter retracts (rises) until 
its top (rest) position (0 %). 
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3.4.7.3 Summary schematics (with Step) 
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3.5 DELAYING THE MEASUREMENT(S) 

A delay for any measurement can be set and activated. 

 

Click  on the toolbar to enable it  (re-click to disable). 

When  is enabled: Before any measurement is started (section 3.7.5), the Wait 

time window appears. 
 

 
 

See the same information than described in Wait time, p. 41, for the indenter 
calibration matrix of measurements), exception: It is applicable here for a single 

measurement or for a matrix of measurements. 
 
INFORMATION: A delay of max. 2 months can be set. 
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3.6 SELECTING THE MEASUREMENT (TYPE OR PROTOCOL) 

Select "Instrument > Start a new indentation…" from menu bar or click  on 

toolbar. The window allows selecting a new measurement (single indentation 
measurement or matrix of several indentation measurements). The measurement 

type which is selected in the top list should be set. Each (available) measurement 
protocol at the bottom of the list is a measurement type (top list) which has been 

previously selected, set and saved (its parameters could be modified is necessary). 
 

  
Fig.49 Define a new measurement window 

 

<Define a new measurement> radio button: 
To select (highlight) one active1) measurement type in the (top) list. 

OR 

<Use a protocol> radio button: 
To select (highlight) one available measurement protocol in the (bottom) list: 
 

- To save (or delete) a measurement type as a protocol, see section 3.7.7 

and to manage the protocols, refer to the Common Scratch & 
Indentation software reference guide in section Managing the 

measurement protocols.  
 
 

 
1) Each inactive measurement type cannot be selected as it is not applicable for the current 

measuring head. 
 

List 

List 

Saved 
protocol(s) 

1) 

(If a protocol is 
selected, its 
parameters are 

displayed here) 

1) 

Matrix 
types 

Default 
protocol(s) 

in bold 
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- Depending on the current measuring head, default protocol(s) in bold and 
at the end of the (bottom) list are present (e.g in Fig.49), with pre-defined 

parameters for certain dedicated sample type. 
IMPORTANT: The sample in use should correspond to the selected default 

protocol. 
INFORMATION: These default protocol(s) cannot be deleted or managed, 

only their corresponding measurement type parameters can be modified if 
necessary.  
 

<OK> button: 
To open the window of the measurement type or protocol selected in a list.  

INFORMATION: Double clicking a measurement type or a protocol in a list does 
the same effect. 
 

The required parameters of the corresponding measurement type window should 
be set (or modified for a protocol if necessary) before running the 

measurement(s); see the following sections for: 
 

• the main description of a measurement type window 
section 3.7.1 

 
• the common loading rate parameter description 

section 3.7.2 

 
• the common acquisition rate parameter description 

section 3.7.4 
 

• all required parameters for each measurement type window; 

see from section 3.7.5 
•  

• the preference parameters dedicated for each measuring head; 
see from section 3.7.6 
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3.7 SETTING THE MEASUREMENT TYPE PARAMETERS 

3.7.1 MAIN DESCRIPTION OF A MEASUREMENT TYPE WINDOW 

A measurement type is selected in Define a new measurement window (Fig.49). 
 

Legends:
     

 
 
 

 
 

 
Fig.50 Measurement type window 

 

 
 

 
 
 

From section 3.7.5, see the specific required parameters for each measurement 
type window. 

 
 
1 With Load or Depth control 

  

Information Parameters to be defined: set/select 

Current setting 

To define (set) the 
measuring head 
hardware parameters 
(section 3.7.6) 

Type of the chosen measurement(s) Load profile sketch 

Acquisition rate 

(section 3.7.4) 

Loading rate 
(section 3.7.3) 
in function of 
time 

To save the current parameters 
as a measurement protocol 

(section 3.7.7) 

To start the measurement(s) with the 
current parameters (section 3.8) 

Loading rate 
profile in 

function of 
Depth1 or Load 

Estimated info fields (section 3.7.2) 

Multicycle: 
number/pause 
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3.7.2 ESTIMATED INFO FIELDS 

 
 
Estimated duration field (in Hour:Minute:Second): 

It provides an estimation time that is necessary to perform the measurement(s) 
defined in the current measurement type window (time is refreshed with different 

parameters). 
INFORMATION: In addition, number of day(s) may appear. 

 

Estimated memory size field (in KB): 
It provides an estimation of the software RAM memory size that is necessary to 

perform the measurement(s) defined in the current measurement type window 
(time is refreshed with different parameters). 
IMPORTANT: In case of a red warning message appears at the left bottom of 

the window, decrease parameter(s) until the message disappears. Otherwise the 
software may crash during the measurement(s). 

 
 
3.7.3 LOADING PROFILES 

The measurement(s) is performed with one of the loading profiles described below. 

Depending on the selected measurement (Fig.49), several loading profiles are 
proposed (one can be selected). 

 
 

3.7.3.1 Linear loading/Constant time loading 

The linear loading or constant time loading applies the indenter force following the 
equation below: 
 

tkF =  
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3.7.3.2 Quadratic loading 

The quadratic loading applies the indenter force following the equation below: 
 

2tkF =  

 

 

 

3.7.3.3 Constants strain rate (CSR) 

This profile is recommended for materials having viscoelastic properties. 
 

The constant strain rate (CSR) applies the indenter force following the equation 
below: 
 

cte
P

1

dt

dP
=

 

 

 

  



 

H70IB103EN-C 86 

3.7.4 COMMON ACQUISITION RATE PARAMETER 

Common parameter to all measurement types; see from section 3.7.5. 

 

 
 
Acquisition rate field: To set the acquisition rate. The value corresponds to the 

number of data point recorded per second during the 
measurement(s). 
Initial value is 10 Hz  

Min. value is 1 Hz and max. 400 Hz 

However, there is no field to set for the following measurements types: 
 

• Standard measurement type section 3.7.5.1, value is fixed to 10 Hz 
 

• Sinus measurement type section 3.7.5.3, value is automatically calculated 

(20x the Sinus frequency value) 
 

• User defined profile measurement type section 3.7.5.7, value depends on the 
load profile segments which are created 

 

• Quick matrix measurement type section 3.7.5.10, value is fixed to 400 Hz 
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3.7.5 PARAMETERS OF EACH MEASUREMENT TYPE 

A measurement type is selected in the Define a new measurement window (Fig.49). 
 

See the following sections which show all windows of each measurement type and 
describe the corresponding parameters which should be set before starting the 

measurement(s). 
 

 

3.7.5.1 Standard 

The Standard measurement type is the simplest single indentation measurement, 
performed in 1 cycle of automatic linear loading/unloading; section 3.7.3.1. 
 

 
Fig.51 Standard window parameters 

 

INFORMATION: About the acquisition rate, see section 3.7.4. 
 

Max load field: To set the max. load to be applied. 

Load Time fixed parameter:  A linear loading rate is computed to reach the max. 
load (above) within 30 sec. 

Unload Time fixed parameter: After the pause (below), a linear unloading rate is 
computed to fully unload within 30 sec.  

Pause field (in sec.): To set a pause at the max. load before unloading. 
Value sets to 0 = no pause. 

  

Section 3.7.7 

Section 3.7.6 

Section 3.8 

Section 3.7.2 
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3.7.5.2 Advanced 

The Advanced measurement type is a single indentation measurement, performed 

in 1 cycle of loading/unloading defined by the user. 
 

 
Fig.52 Advanced window parameters 

 
Linear loading tab below: 

Quadratic loading tab p. 89: 
Constant strain rate (CSR) tab p. 90: 

To select the corresponding loading profile. The related set of parameters is 
described as follows. 

 
Linear loading tab 

 

<Max depth (Load control)> 
radio button/field: 

 
or 
<Max depth (Depth control)>  

radio button/field: 
 

 
OR 

Max load radio button/field: 

To select a depth mode: 

Load controlled measurement. The load 
increases linearly at the defined load rate 

until the max. depth defined is reached. 
or 

Depth controlled measurement. The depth 

increases linearly at the defined loading 
rate (µm/min) until the max. depth is 

reached. 
OR 

To select the load mode and to set the max. 

load to be applied. 

Loading rate field: To set the loading rate to reach the max. depth 
OR max. load (above). 

  

Section 3.7.7 

Section 3.7.6 

Section 3.7.4 

Section 3.7.3 

Section 3.8 

Section 3.7.2 
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Hazardous result 

INFORMATION: With Max depth (Depth control) radio button selected 
(previously described), if Approach speed field value in Hardware parameters 
window / Preferences tab (section 3.7.6) is at least 4 times faster than Loading 

rate field value (previously described), the measurement may have hazardous 
results. 

   

 
 

 
 
Pause field (in sec.): To set a pause at the max. depth OR max. load before 

unloading. 

Value sets to 0 = no pause. 

Unloading rate field: To set the unloading rate to fully unload after the pause. 

Quadratic loading tab 

  
 
Max load field: To set the max. load to be applied. 

Time to max load field: To set the time to reach the max. load (above). 

Pause field:  To set a pause at the max. load (above) before unloading. 
Value sets to 0 = no pause. 

Time to unload field: To set the time to fully unload after the pause (above). 
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Constant strain rate (CSR) tab 

  
 

<Depth control> radio button: 
Min depth field: 

 
Max depth field:  

OR 

<Load control> radio button: 
Min load field : 

 
Max load field:  

To select the depth mode and ... 
To set the min. depth at which the constant 

strain rate starts. 
To set the max. depth to be reached.   

OR 

To select the load mode and ... 
To set the min. load at which the constant 

strain rate starts. 
To set the max. load to be applied. 

Loading rate/load field: To set the loading rate to reach the max. depth 
OR max. load (above). 

Typical range values = from 0.01 to 0.1[s-1] 

Pause field: To set a pause at the max. depth OR max. load 

(above) before unloading. 
Value sets to 0 = no pause. 

An automatic linear unloading rate is performed to fully unload after the pause 
(above). 
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3.7.5.3 Sinus 

INFORMATION: Sinus measurement type is not available (  inactive) in 

the top list of Define a new measurement window (Fig.49) for MHT, UNHT Bio, and 
NHT without the optional Sinus mode/generator (see section 2.1.1.3). 
 

The Sinus measurement type is a single indentation measurement, performed in 
1 cycle of loading/unloading defined by the user. A sine wave is added during the 
loading. This measurement type allows obtaining a depth related analysis; see 

section 4.8.1. 
 

 
Fig.53 Sinus window parameters 

 
Linear loading tab below: 
Constant strain rate (CSR) tab p. 93: 

To select the corresponding loading profile. The related set of parameters is 
described as follows. 

 
Linear loading tab 

Max load field: To set the max. load to be applied. 

Loading rate field: To set the loading rate to reach the max. load 

(above). 

Unloading rate field: To set a linear unloading rate to fully unload 

after the pause (below). 

Pause field: To set a linear pause at the max. load (above) 

before unloading. 

Max. sinus amplitude field: To set the sine wave max. amplitude for the 
loading (above). 

Section 3.7.7 

Section 3.7.6 

Section 3.8 

Section 3.7.2 
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Sinus frequence field: To set the sine wave frequency for the loading 
(previously described). 

Sinus driving mode area 

<Constant depth> radio button: 
OR  

<Linear load> radio button: 

To select the sinus amplitude driven with 

constant depth (Fig.54). Square root 
evolution of sine amplitude. 

OR 

To select the sinus amplitude driven with 
linear load (Fig.55). Linear evolution of sine 

amplitude 

 
Fig.54 Constant depth driving (Acquisition debug window1 purple area) 

 

 
Fig.55 Linear load driving (Acquisition debug window1 purple area) 

 
 
 
1 To display the acquisition debug window (after measurement is performed), see 

section 4.2. 
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Constant strain rate (CSR) tab 

 
 

Min load field: To set the min. load at which the Sinus 
constant strain rate starts. 

Max load field: To set the max. load to be applied. 

Loading rate/load field: To set the loading rate to reach the max. load 

(above). 
Typical range values = from 0.01 to 0.1 [s-1] 

An automatic linear unloading rate is performed to fully unload after the pause 
(below). 

 
Pause field: To set a pause at the max. load (above) 

before unloading. 

Max. sinus amplitude field: 3 same parameters than described for the 

previous Sinus Linear loading tab, p. 91. 
Sinus frequence field: 

Sinus driving mode area 

<Constant depth> radio button: 
OR 

<Linear load> radio button: 
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3.7.5.4 Constant multicycle 

The Constant multicycle measurement type is a single indentation measurement, 

performed in several cycles of loading/unloading defined by the user. Max. and 
min. depths or loads are the same for all measurement cycles. 
 

 
Fig.56 Constant multicycle window parameters 

 

Cycles area 

Number of cycles  

field: 

To set the number of cycles to be 

performed. 
Min. value = 2  

The following parameters are the same for all cycle repetitions which are 
performed (above). 
 

Pause between cycles 
field: 

To set a pause to be done between 
each cycle (above). 

Value sets to 0 = no pause.  

Linear loading tab p. 95: 
Quadratic loading tab p. 95: 

To select the corresponding loading profile. The related set of parameters, is 
described as follows. 

 

Section 3.7.4 

Section 3.7.3 

Section 3.7.7 

Section 3.7.6 

Section 3.8 

Section 3.7.2 
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Linear loading tab 

<In depth (Load control)> or 
<In depth (Depth control)> 
radio button: 

Max depth field: 
 

Unload down to depth field: 
 

OR 

<In load radio> button: 
Max load field: 

 
Unload down to field: 

To select the depth mode, either controlled by 
load or by depth and ... 
 

To set the max. depth to be reached for each 
cycle. 

To set the min. depth to be reached for each 
cycle1 

OR 
To select the load mode and ... 
To set the max. load to be applied for each 

cycle. 
To set the min. load to be applied for each 

cycle1 

Loading rate field: To set the loading rate to reach the max. depth 
OR max. load of each cycle (above). 

Pause field (in sec): To set a pause at the max. depth OR max. load of 
each cycle (above) before unloading. 

Value sets to 0 = no pause. 

Unloading rate field: To set the unloading rate to reach the min. depth 
OR min. load of each cycle (above) after each 

pause (above).  
After the last cycle, it is fully unloaded. 

Quadratic loading tab 

 
 

Max load field: To set the max. load to be applied for each cycle. 

Unload down to field: To set the min. load to be applied for each cycle1 

Time to max load field: To set the time to reach the max. load for each cycle 
(above). 

Pause field (in sec):  To set a pause at the max. load for each cycle (above) 

before unloading. Value sets to 0 = no pause. 

Time to unload field: To set the time to reach the min. load for each cycle 
(above) after each pause (above). 
After the last cycle, it is fully unloaded. 

1 Exception: The last cycle is fully unloaded. 
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3.7.5.5 Progressive multicycle 

The Progressive multicycle measurement type is a single indentation measurement, 

performed in several cycles of loading/unloading defined by the user. The only 
difference with the Constant multicycle measurement type is that the max. depth or 
max. load increases for each measurement cycle (the min. depth or load remains 

the same for all measurement cycles). 
 

 
Fig.57 Progressive multicycle window parameters 

 
Linear loading tab p. 97: 

Quadratic loading tab p. 97: 
To select the corresponding loading profile. The related set of parameters, is 

described as follows. 
 
Cycles area 

Number of cycles field: 
Pause between cycles field (in sec): 

Same parameters described in Cycles area 
(p. 94) of the Constant multicycle 

measurement type. 

 

Section 3.7.4 

Section 3.7.7 

Section 3.7.6 

Auto 

Section 3.8 

Section 3.7.3 

Section 3.7.2 
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Linear loading tab 

<In depth (Load control)> or 
<In depth (Depth control)> 
radio button: 

First depth field: 
Unload down to depth field: 

Max depth field: 
OR 

<In load> radio button: 
First load field: 
Unload down to field: 

Max load field: 

To select the depth mode, either controlled by 
load or by depth and ... 
 

 

To set the max. depth1 for the first cycle. 

To set a min. depth for each cycle2 
To set the max. depth1 for the last cycle. 

OR 

To select the load mode and ... 
To set the max. load for the first cycle1 

To set a min. load for each cycle2 
To set the max. load for the last cycle1  

Loading rate field: To set the loading rate to reach each cycle max. 
depth OR max. load (above). 

INFORMATION: See the same information 
described in Hazardous result, p. 89 of Advanced 
measurement type. 

Pause field (in sec): To set a pause at each cycle max. depth OR max. 

load (above) before unloading. 
Value sets to 0 = no pause. 

Unloading rate field: To set the unloading rate to reach the min. depth 
OR min. load for each cycle2 (above) after each 
pause (above). 

Quadratic loading tab 

  
 

First load field: To set the max. load1 to be applied for the first cycle. 

Unload down to field: To set a min. load to be applied for each cycle2 

Max load filed: To set the max. load1 to be applied for the last cycle. 

Time to max load field: To set the time to reach each cycle max. load (above). 

 
1 Between the first and the last max. depth/load and depending on the number of cycles, 

the software computes a linear increment for each cycle intermediate max. depth/load. 

 
2 Exception: The last cycle is fully unloaded. 

  

Auto 



 

H70IB103EN-C 98 

Pause field: To set a pause at each cycle max. load (previously 
described) before unloading. 

Value sets to 0 = no pause. 

Time to unload field: To set the time to reach the min. load for each cycle1 
after each pause (previously described). 

 
3.7.5.6 Continuous multicycle (CMC) 

The CMC measurement type is a single indentation measurement, performed in 

several cycles of loading/unloading defined by the user. The differences with the 
Progressive multicycle measurement type are: 
 

- There is only a loading profile: constant time loading/unloading. 

- It is only load controlled (no depth control). 
- The min. load increases for each measurement cycle, as well as the max. load. 

 

 
Fig.58 CMC window parameters 

 

The related set of parameters of the unique Constant time loading tab is described 
as follow. 

  

Auto 

Auto 

Section 3.7.4 

Section 3.7.3.1 

Section 3.7.7 

Section 3.7.6 

Section 3.8 

Section 3.7.2 
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Cycles area 

Number of cycles field: 
Pause between cycles field (in sec): 

Same parameters described in Cycles area, 
p. 94 of the Constant multicycle measurement 
type. 

Constant time loading tab 

<Quadratic max load increment> 
radio button: 

 
 
OR 

To select an automatic 
quadratic increment for 

each cycle max. load 
until the last cycle. 

OR 
 

<Linear max load increment> 

radio button: 

To select an automatic 

linear increment for 
each cycle max. load  
until the last cycle.  

First load field: To set the max. load. to be applied for the 

first cycle. 

Unload down to field (in %): To set each cycle min. load. The value is a 

percentage of each current cycle max. load. 
The recommended range value for Oliver & 

Pharr analysis is from 5 to 40 % 
The last cycle is fully unloaded. 

Max load field: To set the max. load to be applied for the last 
cycle. 

Time to max load field: To set the time to reach each cycle max. load 
(above). 

Pause field: To set a pause at each cycle max. load 
(above) before unloading. 

Value sets to 0 = no pause. 

Time to unload field: To set the time to reach each cycle min. load 
after the pause (above). 
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3.7.5.7 User defined profile 

The User defined profile measurement type is a single indentation measurement, 

performed in several segments fully defined by the user. Each segment can be 
different from one to another. 
 

 
Fig.59 User defined profile window parameters 

 
There are load profile or pause segment types. Each segment in the list from top to 

bottom is respectively displayed from the left to the right in the profile area and 
corresponds to the order/shape of the measurement. 

 
The 3 following buttons open the Edit segment window (Fig.60). 
 

<Add> button: To create a new segment (type/parameters) at the bottom of the 
list.

 

<Copy> button: To copy the selected (highlighted) segment at the bottom of the 
list. 

If necessary, the segment can be modified. 

<Edit> button: To modify the selected (highlighted) segment in the list. 

Section 3.7.4 

Section 3.7.7 

Section 3.7.6 

Section 3.8 

List 

Profile area 

Load in brown 

Sinus in red 

First Last 

First 

Last 

Pause 

Depth in blue 
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To change the order of any 
segment, select it 

(highlighted), drag it and drop 
it elsewhere in the list; the 

shape changes accordingly in 
the profile area. 

<Remove> button:
 To remove the selected (highlighted) segment from the list. 

<Clear> button:
 

To clear all segments from the list. 

 
A Warning window asks to confirm one of the previous 

deletions (<Yes> button) or not (<No> button). 

 
Fig.60 Edit segment window parameters 

 
Select a segment type: A loading profile or a pause (becomes highlighted). 

 
The corresponding parameter(s) are active and should be set; remaining 
parameters are inactive. 

 
The active set of parameters for each concerned segment type is described as 

follows.  
 

Loading profile parameters 

Final depth or Final load field: 
For:  For: 

Linear Load End Depth/  Linear Load/ 
Linear Depth/   Linear Sinus/ 
CSR Depth  Quadratic Load/ 
  CSR Load/CSR Sinus 

To set the final depth or final 
load to be reached. 

Segment 
type 

Section 3.7.2 
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Sinus amplitude and Sinus frequency fields: 
For: Linear Sinus/Pause Sinus/CSR Sinus 

 
 

<Sinus constant depth> or <sinus linear load> 
radio button (inactive for Pause sinus): 

To set the sinus wave amplitude 
and sinus frequency to add for 

the loading. 
 

To select one of the sinus 
driving modes described in 

section 3.7.5.3 under Sinus 
driving mode area. 

INFORMATION: A message in red: 'Warning: Outside operational frequencies 1-
40 Hz' could appear. To obtain a correct Sinus analysis, it is recommended to set 
the Sinus frequency value from 1 to 40 Hz (other values do not block the 

measurement). 

Loading rate (unit selected in options) field: 
For: Linear Load/Linear Load End Depth/Linear Sinus 

or 
Loading rate (always in nm/min) field: 
For: Linear Depth 

or 
Loading rate/Load (always in 1/s) field: 
For: CSR Load/CSR Depth/ CSR Sinus 

OR 
Time to final load (always in s) field:   
For: Quadratic Load 

To set one of the 3 active 
loading rates in order to 
reach the final depth or final 

load (previously described). 
 

 
 
 

OR 
To set the time to reach the 

final load (previously 
described). 

Pause parameter(s) 

Pause field: 
For: Pause in Load/Pause in Depth/Pause Sinus 

To set a pause after the segment. 

With Pause Sinus segment type, set 
also the Sinus amplitude and Sinus 
frequency (above). 

INFORMATION: The last segment should be unloaded to “0”. 

 
<OK> button: To valid the current segment settings in the list (Fig.59). 
INFORMATION: An Information window message appears in case of a parameter 

in not properly set. 
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3.7.5.8 Simple matrix 

The Simple matrix measurement type performs a matrix of identical indentation 

measurements with a (same) defined X & Y spacing. The matrix of measurements 
starts from the current position of the tables. 
 

 
Fig.61 Simple matrix window parameters 

 
Indentation matrix definition area 

Delta X and Delta Y fields: 
To set the (relative) distance between each measurement (Indentation 

parameters area, p. 103) for the X and Y axis. 
 

Indentation count X and Indentation count Y fields: 
To set the number of measurements for the X and Y axis. 

 

Distance X and Distance Y info fields: 
According to the setting of the parameters above, the distance between the first 

and the last measurement for the X and Y axis are displayed as information. 
 
Indentation count info field: 

The total number of the measurements which are performed (+ 1 if Include an 
adjust depth offset box is checked, under Parameters for ADO, p. 104) is 

displayed as information. 
 
Indentation parameters area 

<Edit Indentation parameters> button: 

To select one of the following measurement types, the same one is used to 
perform the whole matrix of measurements. 
 

Section 3.7.7 Section 3.8 

Section 3.7.2 
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Measurement type: 
To select (highlight) a measurement 

type. 
<OK> button: 

To open the corresponding window of the 
selected measurement type.  

Double clicking a measurement type does 
the same effects. 
 

The corresponding parameters should be 
set as same as described in the following 

sections. 

INFORMATION: Adjust Depth Offset is not useful for a Simple matrix of 
measurements (see Parameters for ADO below). 
 

Standard 3.7.5.1 Advanced 3.7.5.2 

Sinus 3.7.5.3 Constant multicycle 3.7.5.4 
Progressive multicycle 3.7.5.5 CMC 3.7.5.6 

User define profile 3.7.5.7 
 

Matrix of matrix is possible, 
 

Simple matrix a 2nd window as same as Fig.61 is superimposed 

Quick matrix  3.7.5.10 
Advanced matrix 3.7.5.9 
Visual advanced matrix 3.7.5.11 

 
Parameters for ADO 

Include an adjust depth offset box: 
Only if necessary, check this box to include an ADO before performing the matrix 

of measurements. 
 

<Edit adjust depth offset parameters> button (useful if box above is checked): 

To set the parameters for the included ADO (section 3.4.4.1). 
The ADO automatic process (3.4.4.2) begins once the matrix of measurements is 
started (<OK> button Fig.61). 

 
  

Matrix of matrix 
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3.7.5.9 Advanced matrix 

The Advanced matrix measurement type performs a list of indentation/ADO 

measurements. For each measurement definition which composes the matrix, a 
different position can be defined and a different measurement type (with its 
specific parameters) can be selected. 
 

 
Fig.62 Advanced matrix window parameters 

 

The corresponding position of each measurement definition from the list is 
represented with a cross in the Indentation position graph. Each measurement 
definition is performed in the chronological order of the list (from top to bottom). 

 
Parameters to create and modify each new selected measurement definition 

The 3 following buttons open the Indentation position window (Fig.63). 
 

<Add> button: 
To create a new definition (type/parameters/position) at the bottom of the list. 

 
<Copy> button: 

To copy the selected (highlighted) definition at the bottom of the list. 

If necessary, the definition can be modified (see <Edit> button below). 
 

<Edit> button: 
To modify the selected (highlighted) definition in the list. 

  

List 

Section 3.7.7 Section 3.8 

Red cross: selected definition in the list 
Blue cross(es):  ADO definition(s) of the list 
Light blue cross:  selected ADO definition in the list 

Black cross(es): remaining definition(s) of the list 

A cross can be selected directly in this graph, 
the related definition become selected 
(highlighted) in the list. 
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To change the chronologic order of the 

measurements which is performed, select 
(highlight) any definition, drag it and drop it 
elsewhere in the list. 

<Remove> button: 

To remove the selected (highlighted) definition(s) from the list - Several 
definitions can be selected by pressing <Ctrl> (or <Shift>) key prior to clicking. 

 

<Clear> button: 

To clear all definitions from the list. 
 

 
 

A Warning window asks to confirm one of the previous deletions 
(<Yes> button) or not (<No> button). 

 
When one of the <Add>, <Copy> or <Edit> buttons previously described is clicked. 
 

 
Fig.63 Indentation position window parameters 

 
For each current (selected) definition: 
 

Delta X field: 
To set a relative position for the X axis. 

 

Delta Y field: 
To set a relative position for the Y axis. 

 

<Edit> button: 
To select one of the following measurement types. 
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Measurement type: 
To select (highlight) a measurement 

type. 
<OK> button: 

To open the corresponding window of the 
selected measurement type. 

Double clicking a measurement type does 
the same effects. 
 

The corresponding parameters should be 
set as same as described in the following 

sections. 

 

Adjust Depth Offset 3.7.5.12 
Standard 3.7.5.1 Advanced 3.7.5.2 
Sinus 3.7.5.3 Constant multicycle 3.7.5.4 

Progressive multicycle 3.7.5.5 CMC 3.7.5.6 
User define profile 3.7.5.7 

 

Matrix of matrix is possible, 
 

Simple matrix 3.7.5.8 
Quick matrix  3.7.5.10 

Advanced matrix a 2nd window as same as Fig.62 is superimposed 
Visual advanced matrix 3.7.5.11 

 
To modify positions for several measurement definitions (regular positions) 

INFORMATION: The following features can be useful to define a regular grid for 

the matrix; the initial position and a same distance increment can be applied for the 
X and/or Y axis of the selected definitions in the list (to modify their current 

positions). 
 

 
 

 (e.g. 0) 
 
 

 (e.g. 1) 
 
 

  

 
 

 

 

 

 
Press <Ctrl> (or <Shift>) key and select (highlight) 

several definitions in the list. 
 
For the X axis 
 

To set the initial (absolute) position for the first selected 

definition (highest position selected in the list) 
 

 

To set the increment (relative) distance between each 
remaining selected definition (from top to bottom in the 

list). 
 

 

To modify the current positions according to the selection 
and the 2 settings (above). 

Matrix of matrix 
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(e.g. 0 and 1) 

 

e.g.  

For the Y axis 
 

Same as previously described, exception: It is applicable 
for the Y axis. The selection in the list should be done 

again. 
 

 
 

E.g. the X and Y positions of the selected definitions have 
been modified. 

To set same preferences (hardware parameters) for several measurement 

definitions 

To set in one time the same hardware parameter preferences for several 
measurement definitions, see the following descriptions. 

 

 

Press <Ctrl> or <Shift> key and select (highlight) 
several measurement definitions in the list. 
 

Then right click in the definition list area and select 
"Changes preferences for selected 

indentations" from context menu. 
 

The same parameters (in Hardware parameters 
window / Preferences tab) described for the 

corresponding head below can be modified for all 
selected definitions in the list: 
 

UNHT section 3.7.6.1 
UNHT Bio section 3.7.6.2 
NHT section 3.7.6.5 

MHT section 3.7.6.6 
 

Once the parameters are validate (<OK> button 
is clicked in the Preferences tab), 

 

A Confirmation window asks if the new 
parameters should be applied. 

Click <Yes> button to apply the 
modifications. Otherwise click <No> 
button to not apply the modifications. 
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3.7.5.10 Quick matrix 

The Quick matrix measurement type is similar to Simple matrix section 3.7.5.8, it 

performs a matrix of identical indentation measurements. However between each 
measurement of the matrix, the reference stays in contact with the sample to speed 
up the approaches (and therefore the measurements). 

Set the proposed parameters for 1 cycle of linear loading/unloading (section 
3.7.3.1). 

 
INFORMATION: It is not possible to use the quick matrix with the MHT. 
 

 
Fig.64 Quick matrix window parameters 

 
Indentation parameters area 

Max load field: 

To set the max. load to be applied. 
 

Time to load/unload field: 
To set the time to reach the max. load (above) and also to fully unload after the 
pause (below). 

  

Section 3.7.7 Section 3.8 

Section 3.7.2 Section 3.7.6 
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Pause field: 
To set a (linear) pause at the max. load (above) before unloading. 

Value sets to 0 = no pause. 
 

 
Sinus box: 

To load with a sinus wave, check this box.  
 
 

Sinus frequency field (active if Sinus box above is checked): 

To set the sinus wave frequency for the loading. 
 
Indentation matrix definition area 

Refer to the same Indentation matrix definition area described in the Simple matrix 

measurement type, p. 103. 
 
<Edit adjust depth offset parameters> button  

To set the parameters for the mandatory ADO (section 3.4.4.1). 

The ADO automatic process (section 3.4.4.2) begins once the matrix of 
measurements is started (<OK> button Fig.64). 

 

3.7.5.11 Visual advanced matrix 

INFORMATION: This measurement is only possible with an optional motorized Y 
table and a video system mounted on the instrument. 

 

 

The Table displacement Warning window asks to 

move the sample under the microscope. Before 
clicking <Yes> button, verify the sample height to 
avoid any collision. Clicking <Yes> button opens 

the following Visual advanced matrix (Fig.65) and 
Video windows (Fig.66). 

The Visual advanced matrix measurement type performs a list of indentation/ADO 

measurements. For each measurement definition which composes the matrix, a 
different position can be visually1 or manually2 defined and a different measurement 
type (with its specific parameters) can be selected. 

 
 

 
 
 

 
 

 
 
 

 
1 With the following Video window (Fig.66) 
2 With the following Visual advanced matrix window (Fig.65) 
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Fig.65 Visual advanced matrix window parameters 

 

 
Fig.66 Video window with defined indentations 

  

Current sample position 

Active graph 

List 

Current microscope positon  

on sample position 

Section 3.7.7 Section 3.8 

Active screen area 
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Parameters to create new measurement definitions 

To create a new measurement definition at the bottom of the list, click: 
 

- A position directly on the Video screen. 
OR 

- <Add> button. 
 

The new measurement definition type (and parameters) are the same as the last 

selected (highlighted) definition in the list (a copy but with a different position). 
See how to modify the Measurement type/parameters below and the Position, 

p. 113. 
 

On the Video screen, each defined position is shown with a small square and a 

“number” or “ADO”. Each “number” corresponds to the order of the indentation 
definitions in the list (from top to bottom) excluding the ADO. The selected 
(highlighted) definition in the list appears with a red square. 

 
Parameters for each selected measurement definition 

   

To change the chronologic order of the 

measurements, select (highlight) any 
definition, drag it and drop it elsewhere in 

the list. 

 
 

<Edit> button: 

Measurement type/parameters 

To modify the measurement type of the selected (highlighted) 

definition in the list (Fig.65). 

 

Measurement type: 
To select (highlight) a measurement 

type. 
<OK> button: 

To open the corresponding window of the 

selected measurement type. 
Double clicking a measurement type does 

the same effects. 
 
The corresponding parameters should be 

set as same as described in the following 
sections. 

  

Matrix of matrix 
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Adjust Depth Offset 3.7.5.12 
Standard 3.7.5.1 Advanced 3.7.5.2 

Sinus 3.7.5.3 Constant multicycle 3.7.5.4 
Progressive multicycle 3.7.5.5 CMC 3.7.5.6 

User define profile 3.7.5.7 
 

Matrix of matrix is possible, 
Simple matrix 3.7.5.8 
Quick matrix  3.7.5.10 

Advanced matrix 3.7.5.9 
Visual advanced matrix a 2nd window as same as Fig.65 is superimposed 

 
 
 

<Edit co-ordinates> 
button: 

Position 

To manually change the position of the selected 
(highlighted) measurement definition in the list: 

 

Set other coordinate value(s) than the current 
position. 

 
OR 

 To visually change a measurement definition position from 

the Video screen, click in the middle of the desired square  
(the arrow mouse cursor should become a hand shape 

cursor, otherwise a new definition is created), then drag and 
drop the current red square on the Video screen. 
 

  
before after 

<Remove> button: To remove the selected (highlighted) measurement 

definition(s) from the list - Several definitions can be selected 
using <Ctrl> or <Shift> key before selecting (the definition 

square(s) also disappear from the Video screen). 

<Clear> button: To clear all measurement definitions from the list (and from 

the Video screen). 
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To set same preferences (hardware parameters) for several measurement 

definitions 

 

Same as described in To set same preferences 

(hardware parameters) for several measurement 
definitions for the Advanced Matrix, p. 108. 

Absolute reference position for protocol 

Use absolute position for the map 
box. 

Check this box to always keep the same matrix 
reference if this Visual advanced matrix 

measurement type is saved as a protocol. Each 
time the saved protocol will be selected, the 
sample will be positioned at the same 

reference. See To change the reference 
position, p. 115. 
 

Uncheck to position the sample at the current 
position. 

Methods to move 

 

To move the sample/motorized table(s) use 

the Position control area; for descriptions, 
refer to the Common Scratch & 

Indentation software reference guide in 
section Managing the instrument / 
Position control, exception: Some 

functions are not applicable here. 
 

OR 
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To move the sample/motorized tables to an existing measurement definition 
position, on the Video screen center (crosshair), double click on the desired 

definition in the list. 
 

     
before after 

To change the reference position 

To align the measurement definitions of the matrix with a specific reference position 

on the sample, see the following descriptions. 
 

<Set reference> 
Button: 

To set a new reference at the current sample/motorized tables 
position. 
 

   
before after 

<Edit reference> 
button: 

To manually set a new reference  to another position: 

 

Set different coordinate field value(s) than the 
current position. 
 

INFORMATION: The current position value(s) 
can slightly differ from the one(s) shows on the 

Position control active graph due to the indenter-
microscope distance calibration correction. 

When a new reference is set (above), the X-Y deltas of the definitions in the list are 
not changed, only the origin of map is changed. This allows translation of all 

measurement definitions by selecting new reference/coordinates (origin). 
 
To reopen the Video 

<Open video> 
button 

To reopen the Video window if it has been closed. 
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Ellipse 

To fit an ellipse shape for the matrix, first min. 6 indentations should be defined 
(round shape) in the list (which will be automatically erased later) - ADO(s) are not 
included. 

       
 
<Ellipse> button: To define the following ellipse parameters. 

 

 
Fig.67 Ellipse Matrix Generator window parameters 

 

Set the field parameters in order the software computes new indentation 

definitions in the list for the elliptic fit matrix. 
 

E.g. 10 points (Points field in Angle area) in 3 rows (Points field in Radius 

offset area) = 30 definitions. 
 

A 

A 

B 

B 

C 

D 

C 

D 
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When <OK> button is clicked in Fig.67, the new indentation definitions 
replace the previous ones in list (ADO definition(s) is kept in the list). 

 

       
New computed indentation definitions (e.g. 30) for the elliptic matrix 
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3.7.5.12 Multi-ADO for Advanced matrix & Visual advanced matrix 

REMINDER: For the ADO purpose, read the beginning of the section 3.4. 

 
One or several automatic ADO(s) can be performed at the beginning and/or 
between the indentation measurements for the Advanced matrix (section 3.7.5.9) or 

Visual advanced matrix (section 3.7.5.11). 
 

 
Fig.68 ADO selection 

Select (double click) the Adjust 
Depth Offset (ADO) measurement 
type and set its parameters (section 

3.4.4.1). 
 

- An ADO can be included at the first position in the definition list, before starting 
the indentation measurements of the matrix. 

 

- One or several ADO(s) can be included between the indentation measurements of 
the matrix. 

 

                 
 
 

INFORMATION: Before starting the matrix of measurements, if there is not at 
least an ADO in the first position of the list, a Confirmation window asks to 

continue: 
 

 Click <Yes> button if a successful ADO  has previously been performed 

(section 3.4.2) and is suitable (location) for the whole matrix area. Otherwise 

click <No> button and add an ADO definition in the first position of the list, and 
elsewhere in the list where it is necessary. 

  

First  

List 
Between 

First  

Between 

Between Between 
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3.7.6 MEASUREMENT HARDWARE PARAMETERS (HEAD) 

Click <Change>  /   button located at the right 

(or left*) bottom of the following measurement type window, 
 

Type Section 

Standard 3.7.5.1 

Advanced 3.7.5.2 

Sinus 3.7.5.3 

Constant multicycle 3.7.5.4 

Progressive multicycle 3.7.5.5 

CMC 3.7.5.6 

User define profile* 3.7.5.7, 

 

to modify the hardware parameters. 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

Fig.69 Measurement schematic 

 

See the following sections which described the hardware parameters used during 
the measurement(s). 

Some preference parameters are dedicated1 for each type of measuring head and 
some are common2 for all types of measuring heads. 
The preference preset feature3 allows setting automatic suitable values according to 

the kind of sample material in use. 
 
1 UNHT (sections 3.7.6.1, 3.7.6.3 and 3.7.6.9), UNHT Bio (sections 3.7.6.2, 3.7.6.4 and 

3.7.6.9), NHT (section 3.7.6.5), MHT (section 3.7.6.6 and 3.7.6.9) 
2 Approach distance (section 3.7.6.7), Contact stiffness threshold (section 3.7.6.8), 

Adhesion (section 3.7.6.10) 
3 Preset (section 3.7.6.11) 

  

Pause 

Unloading 

 rate 
Loading 

   rate 

Retract 

   speed 

Retract 

time 

Approach 

speed 

Time 

Load/Depth 

Parameters set in 

measurement type windows 

Parameters are set in Hardware parameters window - Preferences / 

Sensor ranges tab(s) according to the measuring head 

Depth control Depth control Depth or load control 
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3.7.6.1 UNHT Preferences tab 

 
Fig.70 E.g. Step - UNHT with default (presets) parameters 

 

Set all parameters for the indenter & reference approach, contact detection and 
then for the retraction. 
 

Indenter 

 
The Approach speed field determines the velocity at which the 

indenter approaches the sample surface. 
 

See the typical values in the table below: 

1000 to 2000 nm/min 
For max. measurement load Material 

20 to 1000 µN fused silica (hard) 
 

 Tendency: 
For max. loads higher than 1000 µN, set a value higher than 
2000 nm/min, especially for soft materials. 

 
The indenter Contact load field is used to detect the sample 

surface during the approach. The value depends on the desired 
max load value for the measurement. The following table gives 

indications on how to realize measurement in the best conditions: 

Recommended value For max measurement load 

= <10 µN = <100 µN 
 

 Tendency: 
The lower the measurement max load value is, the lower the 

value should be set, in this case reduce the approach speed (set 
above) to keep enough acquisition data points in the curve. 

 

For max measurement load higher than 100 µN, the value can be 
increased (10 % of max measurement load with max. 50 µN); see 
also section 3.7.6.9. 

Section 3.7.6.8 

Section 3.7.6.7 

Section 3.7.6.10 

Section 3.7.6.11 

Section 3.9 
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Reference 

 
The Approach speed field determines the velocity at which the 
reference approaches the sample surface; advised (standard) 
value 60000 nm/min 

 
The reference Contact load field is used to detect the sample 

surface; UNHT uses a patented active surface referencing system 
whose principle consists basically of a reference contacting the 
surface. 
 

See the typical values in the table below: 

Max. value Material 

500 or 1000 µN for most material 

 
Indenter & reference 

 

 

 

The indenter and reference Pre-approach fields are used to 
ensure that the indenter position is higher than the reference 

position before approaching the indenter and reference with 
the approach speed (set above). Standard values 10 % for 

the indenter and 40 % for the reference are most of the 
time suitable. However those values may be different 
depending on UNHT measurement configuration (type of 

mounted indenter/reference, mounting and geometry of the 
sample…). 

 

OR 
 

 
Check the reference-indenter auto-tuning box to perform an 

auto adjustment of the pre-approaches between the 

reference and the indenter: the indenter  and 

reference  become inactive. According to the last 

successful ADO, the software will compute and optimize the 
best indenter and reference pre-approaches. 

INFORMATION: 100 % is the lower/rest position. 
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3.7.6.2 UNHT Bio Preferences tab 

 
Fig.71 E.g. Step - UNHT Bio with default (presets) parameters 

 
Set all parameters for the indenter approach, contact detection and then for the 

retraction. 
 

 
The Approach speed field determines the velocity at which the 
indenter approaches the sample surface.  

 
The indenter Contact load field is used to detect the sample 
surface during the approach; see also section 3.7.6.9. 

 
The Pre-approach field is used to pre-approach the indenter before 

approaching it with the approach speed above. 

For the detailed explanations of those parameters, refer to the Anton Paar 
Bioindenter UNHT3 Bio User Manual in section Indentation measurement 
process / Performing an indentation measurement / Define indentation 

measurement parameters. 
  

(Same parameters for TTX) 

All parameters 
related to the 
reference are 
inactive as there 
is no reference on 

the UNHT Bio Section 3.7.6.8 

Section 3.7.6.10 

Section 3.7.6.7 

Section 3.7.6.11 

Section 3.9 
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3.7.6.3 UNHT Sensor ranges tab 

 
Fig.72 E.g. Step - UNHT with fine ranges 

 
Select suitable + Reference load range, + Indenter load range and Depth range 

according to the used sample/application; it is recommended to use fine ranges 
(e.g. above), to obtain the optimal quality of the signals. 
 

Use the large ranges only if the fine ranges are not sufficient to perform the 
measurement, or in case of saturation. 
 

INFORMATION: This tab is also available in the Calibration window (section 2.4.1). 
 
 

3.7.6.4 UNHT Bio Sensor ranges tab 

 

Similar than UNHT section 
3.7.6.3, exceptions: 
 

- No reference. 
 

- Range values are different. 
 

- It is recommended to use 

the large depth range. 

 

 
 
 

 
 

 
  

With optional extended ranges, all values are doubled, 
except fine Depth range: 
 

 

Fine 

Large 

(Same parameters for TTX) 

(Same parameters for TTX) 

Radio buttons 

related to the 
reference are 
inactive as there is 
no reference on the 
UNHT Bio 

Fine 

Large 
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3.7.6.5 NHT Preferences tab 

 
Fig.73 E.g. Step - NHT with default (presets) parameters 

 
Set all parameters for the indenter approach, contact detection and then for the 

retraction. 
 

 
The Approach speed field determines the velocity at which the 
indenter approaches the surface. 

 
See typical values in the table below: 

Hard material 
Soft material 

< 1 mN > 1 mN 

1000 to 1500 nm/min 2000 nm/min 4000 nm/min 

 

 

Select a suitable Depth range according to the used 
sample/application; it is recommended to use the fine range (e.g. 

above) but if the depth saturates during the following 
measurement, then select the large depth range. 

  

Fine 

Large 

Section 3.7.6.8 

Section 3.7.6.7 

(Same parameters for TTX) 

Section 3.7.6.10 

Section 3.7.6.11 
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3.7.6.6 MHT Preference tab 

 
Fig.74 E.g. Step - MHT with default (presets) parameters, except fine ranges 

 
Set all parameters for the indenter approach, contact detection and then for the 

retraction. 
 

 
The Approach speed field determines the velocity at which the 

indenter approaches the sample surface. 
 

See the typical values in the table below: 

Hard material 

100 µm - Depth range - 1000 µm 

8 or 16.6 µm/min  16.6 µm/min 

 

 
The Contact load is used to detect the sample surface during the 

approach; see also section 3.7.6.9. 
 

See the typical values in the table below: 

Hard material 

100 µm - Depth range - 1000 µm 

0.01 N  0.03 N 

 

1)

  

 

1)

  

Select suitable Load range and Depth range according to the 
used sample/application; it is recommended to use fine ranges (e.g. 

above) to obtain the optimal quality of the signals. Use the large 
ranges only if the fine ranges are not sufficient to perform the 

measurement, or in case of saturation. 
 

IMPORTANT: The Depth range should be the same as the ADO Dz 

range, p. 75 which has been selected for the current successful 
ADO. Otherwise an error message will appear; see section 5.2. 

 

1) Range values can be different with old MCT version. 
  

Fine 

Large Section 3.7.6.8 

Section 3.7.6.10 

Section 3.7.6.11 
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3.7.6.7 Approach distance parameter (UNHT/Bio/NHT) 

 
The Approach distance field is only available for the measuring 

heads equipped with an electronic bridge, such as the UNHT, UNHT 
Bio and the NHT, and can be changed for each new measurement 
in Preferences tab; see from section 3.7.6. 

 
This parameter allows the increasing or decreasing of the indenter 

approach distance before starting to record the measurement. 
 
INFORMATION: The value of the presets corresponding to the 

type of the used sample (section 3.7.6.11) is suitable. 

MHT approach distance 

Otherwise for MHT without electronic bridge, this parameter can be only changed 

in the current ADO parameters window; see section 3.4.7. Therefore the 
approach distance will remain the same for each following measurement. 

 
The parameter is applied according to the last successful ADO. When the approach 
distance value is reached by the indenter, the software starts recording of the 

measurement acquisition data (points). 
 

The sketch below supposes that the sample surface topography is totally flat (no 
holes, no bumps, and no roughness) and the sample is not too soft: 
 

 
 
 

The approach distance value which is set can be approximately seen on the 
following Set the contact point window (Fig.75), after the measurement has been 
performed. 

  

Indenter 

START MEASUREMENT APPROACH ADO 

Sample topography 

Indenter 
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Fig.75 Approach distance on Set the contact point window 

 
The approach distance cannot be exactly as same as the set value because it 

depends on the sample topography (tilt+ roughness) and the sample material (soft 
or hard); see section 4.1.1. 

  

value 
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3.7.6.8 Contact stiffness threshold parameter (All heads) 

All heads use this parameter to detect the sample surface with the indenter. 

 

 

 
Contact stiffness threshold field: 

To set the stiffness threshold at which the contact between the indenter and 
sample surface should be detected (detection sensitivity with a stiffness 

algorithm). 
It is recommended to set the value of the preset corresponding to the type of the 
used sample (section 3.7.6.11). If necessary (for more accuracy), it is possible to 

slightly decrease the preset value; IMPORTANT: However by decreasing too 
much the value, the contact can be detected in the air. 

 

Except NHT, other heads also use the following Contact load parameter (section 

3.7.6.9) to detect the sample surface. The sample surface is detected as soon as 
one of these methods finds it (most of the time the stiffness is detected sooner than 

the force). 
 

 
3.7.6.9 Contact force parameter (not with NHT) 

Additionally to the Contact stiffness threshold parameter (section 3.7.6.8), the 

UNHT, UNHT Bio and MHT instruments also use the Contact load field (unit selected 
in options) to detect the sample surface with the indenter/reference (UNHT). The 
sample surface is detected as soon as one of these methods finds it (most of the 

time the stiffness is detected sooner than the force). 
 

 

 

Contact load field: 
To set the force at which the contact between the indenter/reference(UNHT) and 
sample surface should be detected. 
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3.7.6.10 Retract speed & time parameters for adhesion 

 
(unit selected 
in options) 

 

 

Retract speed and Retract time field values can be changed for 

each new measurement in Preferences tab; see from section 
3.7.6. 
 

The value of these parameters allows studying the adhesion 

between the indenter and the sample. 
 

Both parameters manage the unloading during the adhesion 

phenomenon. 

 

 
 
See section 4.6 to obtain the adhesion force. 
  

Adhesion Force 
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3.7.6.11 Preset of the preference parameters 

In each Preferences tab of the Hardware parameters window (see from section 

3.7.6) there is the "Presets" drop-down menu located at the left bottom of the 
window. Suitable automatic values according to the kind of sample material in use 
can be set with this feature.   

 

 
 

 
 
"Presets" drop down menu: 

To select one of the 3 following presets according to the material of the used 
sample, 

"Default" 
For hard material. 

OR 

"Soft materials" 
OR 

"Ultra soft material" 
 

<'Apply'>  button: 

To apply the current "Presets" drop-down menu selection → The parameters are 

automatically set accordingly. 
 

INFORMATION: For the UNHT/bio, the indenter and reference Pre-approach fields 
automatic values are defined in the Default values tab of the Calibration window 
(section 2.4.3). 
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3.7.7 SAVE AS PROTOCOL (CURRENT MEASUREMENT TYPE SETTING) 

 
 

Located at the left bottom of each 

measurement type window 

(see from section 3.7.5) 

To save the current setting of all parameters as 

a measurement protocol (including hardware 
preference parameters section 3.7.6). 

 

Edit (type) a new 

protocol name and 

click  

to save the 

protocol. 

 

Each saved 
protocol will appear 

in the protocol list 
of the Define a new 

measurement 
window (Fig.49) 

and can be selected 
later. 

 

To erase a protocol, 
only from the list of 
the Define a new 

measurement 
window (Fig.49), 

right click on a 
protocol and select 
"Delete" in the 

context menu. 

  

Protocol list 

Protocol list 
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3.8 MEASUREMENT PROCESS (INDENTATION RUNNING) 

Once the measurement starts, the window below displays the real-time status, 

indenter progression bars and the acquisition curves.  
 

 
 

 
Fig.76 Indentation running… window 

 
IMPORTANT: It is recommended not to use any other software whilst acquisition is 

in progress, as this may interrupt the scheduler and cause discontinuities in the 
acquisition process. Ensure that no screen saver or other time consuming 

applications could start during the acquisition process. 
 

There are 5 real-time action blinking squares in the Status area: 
 

 /  (inactive with TTX-NHT) 

 /  (active with UNHT) 
 /  /  

 
 

  

Real-time acquisition curves Real-time info 

Current measurement 

parameters 

No. of measurements (if matrix)) 

User channel curve(s) 

Combined curve 
Normal load (Fn) vs. Depth (Dz) 

Depth curve (Dz) 

 

Normal load curve (Fn) 
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Stabilization 

Before the indentation starts ( ),  is blinking and 
displays a decreasing time info (e.g. starts from 30 [s]); the stabilization time 
is set in section 2.1.4.2. 

 

As soon as the stabilization time is elapsed 0 [s], the indentation measurement 
starts. 

 

 
To unload the current measurement applied force and start the 

next measurement (if matrix). 

 
To stop all measurement(s) (if matrix), the indenter/motorized 

Z table are immediately retracted. 

INFORMATION: With UNHT and UNHT Bio, the extra UNHT Approach Monitor 

window (Fig.33) can be displayed or deactivated with the UNHT.INI file; 
see section 2.6. 
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3.9 ANALYZING/VISUALIZING THE INDENTATION(S) 

This section is applicable if: 
 

 
 

 

- Microscope installed box has been checked and <Video 
Microscope> radio button has been selected (providing the 

video microscope is present on the instrument); refer to the 
Common Scratch & Indentation software reference 
guide in section Managing the instrument / Hardware 

configuration / My configuration tab. 
 

- Optical analysis after measurement box has been checked in 
the UNHT or UNHT Bio - Hardware parameters window / 

Preferences tab (respectively sections 3.7.6.1 or 3.7.6.2 ). 

 

At the end of the indentation 
measurement process: when the 

Indentation running… window 
(Fig.76) closes, this Warning window 
appears. 
 

Click <Yes> button to open, 

the Video window (Fig.78) and Analyze indentation window (Fig.77), in order to 
(if necessary): 

 

- Refine the indenter-microscope (objective in use only) distance calibration. 

- Analyze/visualize the indentation measurement(s) and capture image(s). 
 

Or click <No> button and go to section 4. 
 
 

 
Fig.77 Analyze indentation window 

  

Section 3.9.1 

 

Parameters of the selected  
indentation in the list 

Curve toolbar 

Section 3.9.4 

Image 
gallery  

Section 3.9.2 

Graph  

Indentation list 

Section 3.9.2 
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 To reopen the Video window. 

 
 

 

Selecting an indentation 

E.g. if a matrix of measurements has been performed, select an 

indentation in the list to automatically move to the corresponding 
area. 

 
 

 

Methods to move for adjustment 

Use these functions to adjust the sample position; refer to the 
Common Scratch & Indentation software reference guide 

in section Managing the instrument / Position control (some 
described functions are not available here). 
 

INFORMATION: 
- <PgUp> and <PgDn> GUI buttons appear in keyboard control 

area when a motorized Z table is present on the instrument 
(e.g. not the case here with a TTX) 

- The displacement area is limited in the zone of the selected 

indentation in the list. 

 

 

Original indentation position 

To move back to the original position (of the selected indentation 

in the list). 

 

Click <Yes> button to 
confirm. 

 

3.9.1 REFINING INDENTER-MICROSCOPE (OBJECTIVE IN USE) DISTANCE 

 CALIBRATION 

It is possible to refine the calibration of the distance between the indenter and the 
video microscope (only for the objective into working positon) from this Analyze 

indentation window (Fig.77), and also using the Video window (Fig.78). 
 

In case of a matrix, select any of the indentation in the list (chose only one); see 

Selecting an indentation above. 
 

 

Centering 

Using the Methods to move for adjustment above, precisely center the chosen 

indentation imprint under the Video screen crosshair and properly adjust the focus 
using <PgUp> / <PgDn> keys in case of motorized Z table (Fig.78). 
IMPORTANT: Be sure the imprint corresponds to the selected indentation in the 

list. 
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INFORMATION: To have the crosshair in the middle of the Video screen, check 
Crosshair box in the Video window; see Video software reference guide for 

description of all features. 
 

 
Fig.78 Indentation imprint centered under Video screen crosshair 

 

 
To refine the calibration of the distance between the indenter and the 

objective into working position, only when the indentation imprint is centered 
(Fig.78). The calibration is not applied to the other objective(s). 

 

It is recommended to click 

<Yes> button in order the 
software performs a backlash 
movement before storing the 

new calibration; wait. 

 

Click <Yes> to save the new 
calibration X, Y and Z 

distance values1) in the 
corresponding fields of the   
Calibrate Indenter Microscope 

distance window2) 

Otherwise click <No> button and restart from Centering , p. 135 until the 

imprint is centered. 
 
1 X, Y distances between the indenter and objective into working position and Z distance, in 

case of motorized Z table, between the sample surface and objective into working position 

(focus). 
 

2 Refer to the Common Scratch & Indentation software reference guide in section 

Managing the instrument / Calibration (Common tabs) / Indenter-microscope 

distance calibration procedure. 
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3.9.2 OPTICAL ANALYSIS (INCLUDES SETTING CONTACT POINT) 

Standard images and depending on the configuration/settings, Multifocus images 

can be captured from the Video screen. Depending on the available options/settings, 
AFM or conscan confocal images can also be captured. 
 

One by one, for each selected measurement in the list; see Selecting an 
indentation, p. 135, the features below can be used: 
 
 

Contact point 

 

 
 

 

See section 4.1.2 

Curve toolbar 
 

If necessary, the contact point can be refined from here 
. Otherwise it can be refined later during the result 

analysis; see the similar explanations as described from 

section 4.1.1.1. 

 

Grab image(s) 

Each of the following active buttons from this Analyze indentation window 

(Fig.77) allows image capture(s) from the current Video screen (Fig.78): Edit an 
image window appears (Fig.79). 
 

Before capturing image(s) below, ensure the focus is adjusted (with Z motorized 
table, see Methods to move for adjustment, p. 135 or with TTX-UNHT use the 

thumbwheels). 
 

 
 

 
 

 

To capture image(s) from the live Video screen, 
 

(standard) images. 
 

 
Multifocus image only if the instrument is equipped with a 

motorized Z table. Otherwise the button is inactive; see 
MultiFocus image(s), p. 138. 

 

 

To capture images from the conscan and/or AFM, if the 

corresponding options are available; otherwise the buttons are 
inactive. 
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This window below allows some settings on the opened image (Title name, 
comments, image features…); refer to the Common Scratch & Indentation 

software reference guide in section Measurement Documents in Curve View 
/ Manipulating Document windows / Image Gallery. 

 

 
Fig.79 Edit an image 

 

When  is clicked, each image is stored (as thumbnails) in the 

image gallery of Fig.79 but also of the Analyze indentation window (Fig.77); in 
each image gallery, double click on a thumbnail to (re)open the corresponding 

image (if there are more than 3 thumbnails, use /  to see 

the previous or following thumbnails in the gallery). 
 

 

MultiFocus image(s) 

A Multifocus image is an image build with an infinite depth of field. We use the 

motorized Z table to capture several images of the same indentation at different 
focus plan (different heights), and after computing all sharpness regions the 

software rebuilds one single image with an infinite depth of field, called Multifocus 
image. 
  

Image 
gallery  
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Surface focus 

Middle focus 

Lower focus 
Multifocus image 

3D mapping 
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3.9.3 OPTICAL VICKERS HARDNESS ANALYSIS 

First adjust the optical hardness Vickers measurement: Place the cursors (center 

and 4 edges) over the Vickers measurement imprint on Video screen (Fig.80); refer 
to the Video software reference guide in section Using the Video Software / 
Hardness (Indentation) (selecting Vickers measurement). 

 

 
Fig.80 Vickers optical measurement adjusted on Video screen = Vickers analysis 

 
(Do not close the Video window) 

 

 
 

<Hardness analysis> button (Fig.77): 
To save the current optical Vickers analysis (Fig.80) in the 2 following places. 
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- The optical Vickers analysis is saved in the image gallery (Fig.77). When the 
image is opened, Edit an image window (Fig.79) shows the analysis details. 
 

     
 

- The optical Vickers analysis is also saved later in the analysis of results 
(section 4.5). INFORMATION: This analysis cannot be defined as automatic or 
added manually afterwards, it is coming only from Analyze indentation window 

(Fig.77) 

 
 
 

3.9.4 ENDING THE OPTICAL ANALYSIS 

 To end the optical analysis (Fig.77). 

 

Click  to close the Analyze 

indentation window (Fig.77). 
IMPORTANT: It will not possible to 

come back. 

  

Analysis  

Image 
gallery 

Analysis  
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3.10 SAMPLE DISPLACEMENT AFTER THE MEASUREMENT(S) 

After the measurement(s) have been performed (section 3.8) or after visualizing the 

indentation(s) (section 3.9), the following window appears. 
 

IMPORTANT: To avoid performing the next calibration/measurement indent inside 
the current indent (current position), the sample/motorized table(s) position should 
be shifted of a minimum displacement1 

 

 
Fig.81 Sample displacement after measurement 

 
X motorized table field: 

To set a min. displacement value1 for the motorized X table. 
 

Y motorized table field: 
If necessary, to set a min. displacement value1 for the motorized Y table. 

 

<OK> button: 
To move the motorized table(s) to the position values set in the previous fields; 

wait. 
 

 
 

<Cancel> button: 
To cancel the displacement (no move). However it is recommended to then use 
the Position control window to move the sample into another suitable position; 

refer to the Common Scratch & Indentation software reference guide in 
section Managing the instrument / Position control. 

 
 
 

 
1 It depends on the current sample material: Approx. 20 x hm 

Pay attention to the displacement unit (e.g. mm in Fig.81), which is set in the options; 

refer to the Common Scratch & Indentation software reference guide in section 

Customizing options / Preferences tab (units). 
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3.11 HEATING MODULE MODE 

3.11.1 ACTIVATION 

This mode and following descriptions are applicable only if: 
 

▪ <Heating stage> radio button is selected for UNHT (section 2.1.1.2)  
▪ Heating stage box is checked for MHT (section 2.1.1.4) 

 
 

3.11.2 ADO 

The Temperature area appears in the ADO window (Fig.82). 
For the standard ADO descriptions and parameters, see section 3.4 
 

 
Fig.82 E.g. MHT ADO window with heating module mode 

 

Heating mode enabled  
box 

To enable the heating of the module before 
performing the ADO process, check this box 

(communication with Heater Software). 
Otherwise uncheck (default) to perform a 
(standard) ADO at ambient temperature. 

Sample target temperature  

field 

To set the target temperature value that will 

be automatically set and applied in Target 
temperature field of the Heater Software. 
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Heating slope 
field 

To set the heating slope value that will be 
automatically set and applied in Slope field of 

the Heater Software. 

Temperature stabilization 
field 

To set the stabilization temperature to wait 
before the ADO process starts. 

Turn off heaters after measurement 
box 

To turn off the heater of the module after the 
last measurement of any started matrix 

measurement types (section 3.6), check this 
box (default).  
Otherwise uncheck to keep the heating 

module at the target temperature until 
manually turned off by the user through the 

Heater Software. 

<OK> 

button 

If the previously described Heating mode 

enable box is checked, the Heater Software 
should be opened by the user before clicking 

this button (otherwise, a Confirmation 
window appears).  
Then, to heat the module according to the 

previously described parameters, click this 
button.  

 
3.11.3 TEMPERATURE SCAN MEASUREMENT TYPE 

The Temperature scan is active in Define a new measurement window (section 3.6) 

at the very bottom. 
 

 
 

Select this measurement type. 
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Fig.83 Temperature scan parameter window 

 
The standard parameters are similar to the ones described for the Simple matrix 

measurement type (section 3.7.5.8), except for the following ones. 
 
Temperature min 

field 

To set the minimum temperature for each measurement. 

Temperature max 
field 

To set the maximum temperature for each measurement. 

Temperature steps 
filed 

To set the desired delta temperatures between the min 
and max (previously described); the software adjusts 
automatically the different temperatures (based on the 

steps value) and performs the measurement at each 
temperature.  

Indentation repetition 
field 

To set the number of measurements (defined through 
<Edit Indentation parameters> button). The distance 

between each measurement performed at the same 
temperature is defined in Delta X field and the distance 

between measurements performed at different 
temperature steps is defined in Delta Y field. 

<OK> button Before clicking this button, ensure that the Heater 
Software is opened. 

Then, to start the defined temperature scan matrix 
measurements, click this button. 

Later, the statistics view allows to display the results versus temperatures (Refer to 
the Common Scratch and Indentation software reference guide in section 

Measurement documents in statistics view). 
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4 ANALYSIS OF RESULTS 

After the measurement process of the indentation(s) is completed, the main result 
analysis window appears (Fig.84). 
 

Adjustments (analysis method, curve display, contact point, overlays…) and 

parameter changes (indenter, Poisson’s ration…) can be performed in this window. 
After most of the parameter changes, an automatic recalculation of the analysis 

result is performed by the software.  
 

By default, the curve view  is selected on the main toolbar. 
 

For the main toolbar  and ; refer to the Common Scratch & Indentation 

software reference guide in section Measurement documents in curve view / 
Document window interface / Information/measurement tabs / 

Measurement tab. 
 

 
 
 

 
Fig.84 Result analysis window (curve view default setting) 

  

Additional toolbar (p. 147) 

Result curve(s) 
graph area(s) 

Zoom tool 

Info from the graph curve cursor 

Analysis type(s) 
& 

result area 

Measurement 
parameter area 

Overlays 

Image 
gallery 

Indentation info 
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Additional toolbar 

 
 
 

 

 
 
 

 
 
 

 
 

 
 
 

 
 

 

4.1 INDENTATION CURVE(S) 

For each active measurement 

 

 
The indentation curve icon in the additional toolbar shows (selected): 
 

- The displayed indentation curve(s) (section 4.1.2) 
 

- The indentation curve features: 
 

Contact point(s) (section 4.1.1) 

Smoothing (section 4.1.3) 
Export (section 4.1.4) 

 
The indentation curve(s) and features can be hidden (if unselected). Only if 

the analysis curve(s) is active and selected  (section 4.7). 

  

 Contact point; section 4.1.1 

Indentation curve(s); 
section 4.1 

Display; section 4.1.2 

Filter; section 4.1.3 

Export; section 4.1.4 

Overlays; 
section 4.4 

Analysis methods; 

section 4.5 

Analysis curve(s); 

section 4.7 
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4.1.1 SETTING THE CONTACT POINT 

From the result analysis window (Fig.84), there are several ways to open the Set 

the contact point window (Fig.85), which allows to verify, refine (change) the 
contact point for each available measurement of each desired active group: 
 

 

- For the active group tab, select 

"Edit > Group > Change contact 
point…" from menu bar. 

 

- Right click on the desired group tab 

and select "Change contact 
point…" from context menu. 

 

- For the active measurement tab 

Select "Edit > Indentation > Set 
contact point…" from menu bar 

(only the contact point for this 
measurement will be opened). 

 

 
 

 
 
- Right click any measurement tab 

and select "Set contact point…" 
from context menu. 

 

- For the active group tab, click  

on additional toolbar. 
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Fig.85 Set the contact point window (default settings) 

 

 

4.1.1.1 Contact point features 

Left graph 

 

If there are several measurements, the measurement numbers are 
displayed on the left top of the window. The active measurement is 

highlighted and its corresponding curves are displayed on the left graph. 
 

To verify or refine (change) the contact point of each indentation 
measurement, select (one at a time) each active measurement by: 
 

- Clicking the measurement number # 
- Pressing the <'Up arrow'> or <'down arrow'> key 

 

In case of a single measurement, there is no measurement # number 
displayed: it is the active measurement. 

 
To center the left graph displayed curves on contact point. 
If the zoom tools are used, click this icon to center the left graph, where 

the important zone to verify/refine the contact point is displayed. 

    

The zoom tools and cursor information are available 
on both left and right graphs; refer to the similar 

explanations as described in the Common Scratch 
& Indentation software Reference guide in 

section Measurement documents in curve view 
/ Document window interface / Graph area 
tools / Zoom. 

Left graph Right graph 
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To display/hide the indentation curve(s) in/from the left graph: 
 

depth h vs. time 
 

and/or 
 

force F vs. time 
 

and/or 
 

stiffness vs. time 

 
 

INFORMATION: By default, 
only depth and force are 

displayed , which is at 

least advised to verify/refine 
the contact point. 
 

 
 

 
 
 
 

Fig.86 Stiffness curve is displayed in addition 

 To restore the contact point automatically detected by the software. 
 

INFORMATION: By default after the measurement process, the contact 
point for each available measurement is automatically detected  

(inactive). 
 

See section 4.1.1.2 (verify/refine contact point). 

 

Right graph area 

The right graph always displays the available measurement combined curve(s), 
force F vs. depth h 
 

 

The selected active 

measurement # (highlighted 
in the left top of the window) 
curve is displayed in dark red 

color. 
 

If the mouse cursor is placed 
on any measurement #, the 
corresponding curve becomes 

highlighted. 
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4.1.1.2 Verifying/refining the contact point 

The contact point is automatically detected (  inactive in Fig.87) with a 'slope' 

rupture of the h (indentation depth Pd) and F (indentation force Fn) curves 

(depends on the material, speed, indenter). 
 

The contact point is defined where the vertical X red graph cursor is located. 
 

 
Fig.87 Automatic contact point will be manually refined 

 
 

The best contact point is the first break point in the approach slope of the h depth 
curve, and is the first point with a no zero force of the F force curve. Therefore it is 

necessary to zoom to this zone; see the previous section 4.1.1.1. 
 

INFORANTION: For high load measurement, it is difficult to see the change in the 
F curve, 

 

 
Large zoom (e.g. 90x) on F curve 

 

therefore it is better to use the h curve to refine the contact point. 
 

To manually refine (change) the current contact point, see the following 
descriptions. 

  

F h 

Automatique contact point Best contact point 

Automatique 
contact point 
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To manually set (refine) the contact 
point 
 

Place the vertical black cursor 
(X scale) on the graph where, 

h curve starts to peak 
F curve starts to rise, 

and at this specific location: 
 

- Double click 

OR 
- Right click and select Set contact 

point from context menu. 
 

If necessary, click  (it became 

active in Fig.87) to automatically re-

define the contact point. 
 

When the contact point changes 
(different location), the curves and 

statistics are updated and the analyses 
are recalculated without leaving the 
Set the contact point window (Fig.87). 

This allows seeing in real time the 
impact of the contact point. 

 
E.g. Oliver & Pharr in the analysis 
result area: 

 

 
Main results values with automatic 

contact point. 
 

 
Main results values with refined (manual) 

contact point. 
 

Some Additional results values also 

change accordingly. 

 

  

F 

h 

The new and precise 
contact point 

Automatique 

Refined 
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4.1.2 INDENTATION CURVE DISPLAY 

 To display (by default) the force F vs. depth h combined curve. 
 

 

OR 
 

 

 
 
 

 

 
 

To display/hide the following curve(s): 
 

Force F vs. time 
 

and/or 
 

Depth h vs. time 
 

 
 

and/or ... 

Time 

F 

h 

h F 
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… 
 

User channel 1 
 

and/or 
 

User channel 2, 

 
if activated 
and set prior to the 

measurement(s). 
 

 
 
 

 
 

 

 To also display/hide the previously described curves on/from the graph. 

 

The context menu allows a quick selection (overview) of 
the curves. 

 To adjust the graph scale(s) for the displayed indentation curve(s). 

 

Also select "Edit > 
Document > Adjust 

curves scales" from 
menu bar to open this 

window. 
 
For the detailed 

description of this 
window, refer to the 

Common Scratch & 
Indentation software 
Reference guide in 

section Measurement 
documents in curve 

view / Manipulating 
document windows / 

Adjusting curve scale. 
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4.1.3 FILTERING THE INDENTATION CURVE(S) 

This feature is applicable with any indentation displayed curve(s) , or / / 

 (if activated)/  (if activated) on the graph; see section 4.1.2. 

 

 

E.g. there is noise on the 

displayed combined curve. 

 To activate the Smoothing (filter) slider on the additional toolbar. 

 

With the mouse cursor, 
 

 
 

move the slider to select a 
filter size (sliding average) 
which is applied on the 

displayed curve(s). 
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4.1.4 EXPORTING ALL INDENTATION CURVES 

 
 

 To export all indentation curves. 

This window allows: 
 

 
 
Then click <Save> button. 

- Choosing a location 

where to save the 
export text file. 

 

- Modification of the 

default File name: 
corresponding to the 
measurement file 

name with current 
measurement #. 

 

- Changing of the default 

1000 points .TXT file 
format. 

 

  

In the saved text file, there are from top to bottom: 
 

 
… 

 
… 

 

 
 
- The indentation measurement 

type and its parameters. 
 

 
 
- All current analysis number(s) 

and their results. 
 

 
 
 

 
 

 
 
 

- The point values for each 

curve: 1000 points 
(resampling) or raw points 

(measured points) previously 
selected when exporting. 
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4.2 ACQUISITION DEBUG (DRIVING CURVES) 

To display the instrument driving curves and all signals, select "Edit > Indentation 

> Show signals…". 
 

 
 

On the left of the window, the Y axes for all curves are always displayed and the 
related curve color square legends with names are displayed at the bottom of the 

window. 
 

'X axis time'  icon: 

To select the total time of the graph X axis. A context menu allows selecting one 
of the several proposed times. 

 

Show/hide curves  icon: 
To show/hide curves on/from the 
graph. A context menu allows a quick 

selection of the curves; each curve 
name with its color square highlighted 
is shown on the graph. 

 

 

Clear graph  icon: 
To clear all curves from the graph.  

 

Export  icon: 
To export all curves from the graph (even if some are not shown). A Save as 
window appears: Browse where to save the export curve file on the acquisition 
system, type a file name with the extension .TXT (not automatic) and click 

<Save> button.  
 

'Zoom' tools: 

Same as described in the Common Scratch & Indentation software 
reference guide in section Measurement documents in curve view / 

Document window interface / Graph area tool. 
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4.3 NHT SPRING COMPLIANCE 

This section is only applicable for NHT. 

 

 
 
 

 

The spring compliance value is taken to calculate 
the Main and Additional results. 

 
This spring compliance value is computed by the 

software: it uses the Fn curve zone (approach) 
just before the contact point. 
 

If the contact point is changed (section 4.1.1), 
the value is recomputed and the results 

recalculated. 

 

 
 
 

 

IMPORTANT: If the difference between the 

computed value (described above) and the 
factory1 value is larger than 20 %, the message 
“Warning: Check contact point” appears in the 

measurement parameter area. Therefore check 
the contact point (section 4.1.1.) 
  

The additional message “(Factory spring 

compliance: value1)” is also displayed in the 
measurement area. 

 

 
 
 

 
 

 
1 Factory value was set in the Factory spring compliance field of the NHT Ranges tab (Fig.6); 

see from section 2.1.3. 
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4.4 OVERLAY PROPERTIES (INDENTATION COMBINED CURVE) 

The surrounded icons on the additional toolbar below are only applicable with the 

Oliver & Pharr, Tangent and Hertz analysis methods (section 4.5), and with the 

indentation combined curve  displayed on the graph (section 4.1). 

 

 
Fig.88 E.g. all overlay properties are displayed 

 

Display 

 
To display or hide on/from the graph the overlay properties which are selected 
below. 

 To select the overlay properties which should be shown.
 

 
Default setting (see Fig.84) 

Check each overlay 

property box which should 
be displayed (uncheck to 

hide). 
 
 
1) Linear 
2) Power law 
3) In addition tangent is 

extended 
4) Upper and lower bounds for 

the fit and tangent; see Set 

range, p. 160 

  

2) 

1) 

4) 

3) 
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Set range 

To set the upper/lower bounds for the fit and the tangent (not for Hertz) of the 
current analysis (e.g. Oliver & Pharr): 
 

 - Click this icon on the additional toolbar. 

 

- Right click in the analysis result area and select 
"Properties…" from context menu. 

 

Set a percentage of Fmax to define 
the upper and/or lower bounds for 

the unload fit (Oliver & Pharr and 
Tangent analyses) or for the load 

fit (Hertz analysis). 
 

Default analysis values: 
 

Oliver & Pharr 98 % and 40 % 
Tangent 95 % and 70 % 

Hertz 98 % and 10 % 

 

With new value(s) set above, 

 
 

 
the Main results and Additional results values are 

recalculated in the analysis result area. 
 
 

 
 

 
 
 

 
 

IMPORTANT: If necessary, scroll down in the result 
analysis area to display the current upper and 
lower bounds values (Unload fit or Load fit for 

Hertz analysis) under Parameters section. 

  

Upper 

Lower 
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4.5 MANAGING THE ANALYSIS METHODS 

4.5.1 ADDING (MANUALLY) ANALYSIS METHOD(S) 

From the results, to manually add new analysis method(s) for each: 
 

Active document (all measurements of its groups) 
 

- Select "Edit > Document > Add new analysis…" from menu bar. 
 

Active group (all its measurements) 
 

 

 
 

- Select "Edit > Group > Add new analysis…" 

from menu bar. 
 

- Right click on the group tab and select "Add new 

analysis…" from context menu. 

Active measurement 
 

 
… 

 

 
 

- Select "Edit > Analysis > Add new…" from menu 
bar. 

 

 
 

- Click  on additional toolbar. 

 
 

- Right click in the analysis result area and select 

"Add new…" from context menu. 

 

See the following Create a new analysis window (Fig.89). 
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Fig.89 Create a new analysis window 

Select (double click) the desired 
analysis method, e.g. Tangent. 

 
 

 
 
If there is already more than one analysis, a 

new analysis method tab (e.g. 2) appears and 
calculates the Main results and Additional 

results values for this new (current) analysis 
method; see each detailed analysis method 

results from section 4.6 to 4.10. 
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4.5.2 AUTOMATIC ANALYSIS METHOD(S) 

It is possible to automatically add several analysis methods at the end of the 

measurement process for each measurement. 
 

The following setting should be done before starting the measurement(s). 
 

 

Select "File > Options…" from menu bar. 

 
Fig.90 Preferences tab in Options window 

In the Analysis 
automatically 

calculated area, 
check each desired 

analysis method box 
which should be 
automatically 

calculated after each 
measurement. 

 

 

 
 

E.g. 1 tab Oliver & Pharr and active 2 tab 

Tangent analysis methods are automatically 
created in the analysis result area after the 
measurement(s); see each detailed analysis 

method results/curves from section 4.6 to 4.10. 
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4.5.3 DELETING ANALYSIS METHOD(S) 

Delete all methods 

To delete all the analysis methods for each: 
 

Active document (all measurements of its groups) 
 

- Select "Edit > Document > Delete all analyses…" from menu bar. 
 

Active group (all its measurements) 
 

 

 
 

- Select "Edit > Group > Delete all 
analyses…" from menu bar. 

 

- Right click on the group tab and select "Delete 
all analyses…" from context menu. 

Active measurement 
 

 
 
 

 

- Select "Edit > Indentation > Delete all 
analyses…" from menu bar. 

 
 

- Right click on the group tab and select "Delete 
all analyses…" from context menu. 
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Active analysis method 
 

 

- Right click on the analysis method tab, or on the 

analysis result area and select "Delete all…" 
from context menu. 

 

A Warning window appears, Click  to confirm the selected deletions or 

click  to keep them. 

 

 
Delete the active method 

To delete the active analysis method: 
 

 

 
  

- Select "Edit > Analysis > Delete…" from 

menu bar. 
 

 
 

- Click  on additional toolbar. 
 

- Right click on the analysis method tab, or on the 
analysis result area and select "Delete…" from 
context menu. 

A Warning window appears. Click  to confirm the active method deletion 

or click  to keep them. 
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4.6 ADHESION ANALYSIS METHOD & RESULTS 

See also section 3.7.6.10 (measurement preference parameters). 

 

 
Fig.91 Adhesion Force of current 

measurement is displayed 

After a measurement(s), to manually create an 

adhesion analysis, see section 4.5.1 and 
 

double click 
 

 
Otherwise before a measurement(s), see 

section 4.5.2, this  box was 
checked. 

 

 

Click  on the additional toolbar and adjust the Min Fn scale (Fn<0); refer to the 

Common Scratch & Indentation software Reference guide in section 
Measurement documents in curve view / Manipulating document windows 
/ Adjusting curve scale. 

  

Adhesion Force 

F < 0 
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4.7 ANALYSIS CURVE(S) 

For each active measurement 

 

   
 
This icon is active on the additional toolbar only with: 
 

• Martens hardness analysis method 
 

• Sinus mode Analysis method (only with a Sinus measurement)  
 

• Oliver & Pharr analysis method only with a Progressive multicycle or a CMC 
measurement type. 

 

 

 To show/hide: 
 

- The displayed analysis curve(s). 
- The analysis curve features: depth or cycle mode, scale adjustment(s), 

export. 
 

See the following sections for descriptions of the related icons. 

 

 

Analysis and 

indentation curves 
(section 4.1) can be 

displayed on the 
same time. In that 
case, each analysis 

curve is displayed on 
the upper graph and 

each indentation 
curve is displayed in 

the lower graph. The 
height size of the 
graphs can be 

adjusted by moving 
up/down the cursor 

between the 2 graph 
areas  
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4.7.1 ANALYSIS CURVE DISPLAY 

 
Fig.92 Displayed analysis curves on the graph 

 

 

With Martens analysis method, only  is available below. 

 
 
 

 
 
 

 

To switch between the 2 modes below (X axis scale): 
 

Depth mode; curves are displayed as a function of penetration depth 
(default) 

 

OR 
 

Cycle mode; curves are displayed as a function of the cycle numbers. 

 To show (by default)/hide the elasticity curve. 

 To show (by default)/hide the hardness curve. 

 To show/hide the storage modulus curve. 

 To show/hide the loss modulus curve. 

 To show the tangent curve. 

 To show the stiffness curve. 

 To adjust the graph scale(s) for the displayed analysis curve(s); see the 
following window. 
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For the detailed description 

of this window, refer to the 
Common Scratch & 

Indentation software 
Reference guide in 
section Measurement 

documents in curve 
view / Manipulating 

document windows / 
Adjusting curve scale. 

 
4.7.2 EXPORTING ALL ANALYSIS CURVES 

 
 

 
To export all analysis curves, even if they are hidden from the graph; refer to 

the similar explanations as described in section 4.1.4, exceptions: 
 

- Type a File name 
 

- There is only one .TXT file format available  (raw). 
 

- The saved text file contains only the points for each curve (raw: measured 

points). 
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4.8 DYNAMIC ANALYSES 

See also section 4.7. 

 
4.8.1 SINUS MODE ANALYSIS METHOD & CURVE RESULTS 

 

After a sinus measurement(s), to manually create a 
dynamic sinus analysis, see section 4.5.1 and 
 

double click .
 

 
Otherwise, before a measurement(s), see section 

4.5.2, this box  was checked. 

 

The Main results are 
the curves themselves. 

 

To filter and/or to display more points for the 

displayed sinus analysis curve(s), click  on the 

additional toolbar, or right click on the analysis 

result area and select "Properties…" from 
context menu. 

 

To set the following number of 
periods. IMPORTANT: With odd 

numbers: 
 

 
 

AND/OR 
 

 
 

See the following parameter 
effects on the analysis displayed 

curves(s) only. 
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Number of periods per point: number of sinus periods used to compute each 
point of the displayed analysis curve(s). 
 

Number of periods between each point: spacing (in period) between the 
computed points (2 consecutive) of the displayed analysis curve(s). 
 

 

With both default values = 5 
 

 
 

and with the curve points  
displayed for a better 

understanding; see the 
Common Scratch & 

Indentation software 

reference guide in section 

Measurement Documents in 

Curve view / Document 

window interface / Graph 

area tools / Curve acquisition 

line/points. 

 

If the Number of periods per 
point value is increased, 

e.g. 11, each displayed curve 
is filtered. 
 

 

 

If the Number of periods 
between each point value 

is decreased, e.g. 1, there 
are more points displayed for 
each displayed curve. 
 

 

 

INFORMATION: The Hypothesis values are coming from the 
UNHT & NHT Dynamic calibration (Sinus) , p. 19. 

 

The current Parameters set above (Number of periods fields) 

are also displayed in the analysis result area. 

  



 

H70IB103EN-C 172 

4.8.2 OLIVER & PHARR ANALYSIS CURVE(S) FOR CMC MEASUREMENT TYPE 

 

After a CMC measurement(s), to manually create 

a Oliver & Pharr analysis, see section 4.5.1 and 

double click .
 

 
Otherwise, before a measurement(s), see section 

4.5.2, this box  was checked. 

In addition to the indentation curves, the analysis curves are available for such type 
of measurement (CMC). 
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4.9 CREEP ANALYSIS METHOD & RESULTS 

INFORMATION : Creep analysis method is only available for measurement(s) with 

spherical indenter; otherwise it is inactive. 
 

 

After a measurement(s), preferably with a 
constant force and a significant pause time, to 

manually create a creep analysis, see section 

4.5.1 and double click .
 

 
Otherwise before a measurement(s), see section 
4.5.2, this box  was checked. 

 

Only display the h 

depth  curve and 

display the single 

overlay fir for this 
analysis (Kelvin-Voigt 
material model 

element) . 

 

Use the zoom tools 
 to 

better see the fit on 
the pause; see the 

Common Scratch & 
Indentation 

software reference 
guide in section 

Measurement 
Documents in Curve 
view / Document 

window interface / 
Graph area tools / 

Zoom and Curve 
acquisition 
line/points. 
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Element(s) setting 

To increase/decrease the Kelvin-Voigt material model elements, click  on the 

additional toolbar or right click on the analysis result area and select Properties… 
 

 
 

 

To set (increase or 
decrease) the 

  count value; 

e.g. increase to 2. 
 

 = 1 

element as shown 
above. 

For each change of the element count above: The fit on the curve is adapted and in 

the analysis result area, the Main results and Additional results values are 
recalculated, and the current Element(s) count value is displayed. 
 

 
  

Current fit with 1 element count 
(zoom in) 

E.g. the previous Element(s) field has been changed from 1 to 2 
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4.10 HERTZ ANALYSIS METHOD & RESULTS 

INFORMATION: Hertz analysis method is only available for measurement(s) with 

spherical indenter; otherwise it is inactive. 
 

 
 

 

 
Fig.93 Hertz analysis 

 
 
For each change of the upper/lower bound, 

the load fit on the curve is adapted and in 
the result analysis area, the Main results 

and Additional results values are 
recalculated, and the Load fit values are 

displayed. 

After a measurement(s), to manually 
create a Hertz analysis, see section 

4.5.1 and double click . 

 

Otherwise before a measurement(s), 
see section 4.5.2, this  box  was 

checked. 
 

The upper and/or lower bound 
value(s) for the load fit can be 

changed; see the similar overlay 
properties described in section 4.4, 
exceptions: 
 

- Here they are for the load fit. 
 

 
 

- The load fit is always displayed 
and only the upper/lower bound 

values (range) and/or 
extrapolation fit can be 

displayed/hidden. 
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Information 

Hertz’s model is used for spherical contact with plane for the following reasons: 
 

- Some soft materials do not comply with O&P conditions (no plastic 

deformation). 
 

- Elastic (poroelastic) deformation is predominant. 
 

- Very often spherical indenter is used. 
 

Depth offset is included to account for soft layers 'floating' above the surface 
 

 

Hertz’s analysis 

included in the 
Indentation Software is 
 

( ) 2
3

of f setr hhRE
3

4
F −=  
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4.11 HYPOTHESIS 

For each active measurement, in the analysis result area under the Hypothesis 

section, several warning messages can appear and the Poisson’s ratio is displayed 
and can be changed; see the following sections for the detailed descriptions. 

 
 
4.11.1 INDENTER NOT CALIBRATED 

 

If the used indenter was not calibrated before 
performing the measurement (Indenter properties 
window Fig.25), the warning message 

“!!! Indenter not calibrated !!!” appears. 
 

INFORMATION: With the UNHT Bio, most of the 

time spherical indenters are used and do not need 
to be calibrated. 
 

If necessary, the indenter can be changed with 

another one which was calibrated; see section 
4.12.2. 

 
4.11.2 m OUT OF O&P HYPOTHESIS 

 

Under Additional results area, if m (exponent in 

the O&P fit of the indentation curve unloading 
part) is > 2, the warning message 

“m out of O&P hypothesis” appears. 
 

INFORMATION: This message appears most of 

the time with soft material samples as they do not 
necessarily comply with the Oliver & Pharr (O&P) 
hypothesis; that is why other types of analysis are 

more appropriate, e.g. Hertz analysis 
(section 4.10). 

 
m value can be changed (a little) by changing the 
upper/lower value of the bounds; see the overlay 

properties section 4.4. 
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4.11.3 OUT OF INDENTER TIP CALIBRATION 

The indenter tip calibration process is performed between a min. and a max. force 

resulting in a known contact depth range, hc 
 
 

Fig.94 Indenter properties window (section 2.5.4) 

 
 
 

 

 
 

 
Under Additional results area, If hc is out of the 

indenter tip known calibration range (Fig.94), 
either smaller or bigger, the warning message 
“hc out of calibrated range” appears. 

  

Indenter tip 

known calibration range 

Min hc Max hc 
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4.11.4 CHANGING THE POISSON’S RATIO 

To change the current Poisson’s ratio for each: 

 
Active document (all measurements of its groups) 

 

-  Select "Edit > Document > Change Poisson’s ratio…" from menu bar. 
 

Active group (all its measurements) 
 

 

- Select "Edit > Group > Change 

Poisson’s ratio…" from menu 
bar 

 
- Right click on the group tab and 

select "Change Poisson’s 
ratio…" from context menu 

Active measurement 
 

 
 

 

- Select "Edit > Indentation > 
Change Poisson’s ratio…" from 
menu bar 

 
 

 
 
 

 
 

 
 
 

 
- Right click in the measurement 

parameter area, or on the 
measurement tab, and select 
"Change Poisson’s ratio…" 

from context menu. 

 

This window allows changing of the 

current Poisson’s ratio value for the 
measurements(s) previously 
selected. 
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To set another Poisson’s ratio value. 

 
To reset the Poisson’ ratio with the value set during 

the new document/group creation. 
 

 

 

In the analysis result area, for each change of the 

Poisson’s ratio value (set above), a new value for 
EIT in Main results section is recalculated 

accordingly. 
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4.12 MANAGING THE INDENTER IN THE RESULT ANALYSIS 

The indenter or some of its parameters can be changed. 

 

 

Recalculated results 

For changes of the indenter properties 
(some parameters/fit method); section 
4.12.1, 

 

AND/OR 
 

for each change of the indenter; section 

4.12.2, 
 
the Main results and Additional results values 

in the analysis result area are recalculated 
for each concerned measurement. 
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4.12.1 INDENTER PROPERTIES 

To change some parameters of the current indenter for each active measurement 

(only): 
 

 
 

 

- Select "Edit > Indentation > Indenter 
properties…" from menu bar 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

- Right click in the measurement parameter 
area, or on the measurement tab, and 

select "Indenter properties…" from 
context menu 

 

INFORMATION: If necessary, scroll down in 
the measurement parameter area to display 

the current indenter information. 

 

The Indenter properties window appears and 

allows changing of: 
 

- The indenter parameters, except the 
indenter Type (section 2.5.1). The 

indenter information is updated in the 
measurement parameter area. 

 

- The indenter fit method (section 2.5.4). 
 

INFORMATION: From here, it is not 
possible to calibrate the indenter (the 
button <Calibrate> is hidden). 

For each change of the indenter properties, see Recalculated results, p. 181. 
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4.12.2 CHANGING THE INDENTER 

To change the current indenter for each: 

 
Active document (all measurements of its groups)  

 

-  Select "Edit > Document > Change indenter…" from menu bar. 

 
Active group (all its measurements) 

 

 

- Select "Edit > Group > Change 
indenter…" from menu bar 

 

- Right click on the group tab and select 
"Change indenter…" from context menu 

Active measurement 
 

 
 

 
Fig.95 Measurement parameter area 

- Select "Edit > Indentation > Change 
indenter…" from menu bar 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

- Right click in the measurement parameter 
area, or on the measurement tab, and 
select "Change indenter" from context 

menu 
 

INFORMATION: If necessary, scroll down in 
the measurement parameter area to display 

the current indenter information. 
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This window allows changing of the 
current indenter for the measurement(s) 

previously selected. 

 

To change the current indenter, with 
another available one. 

For each change of the indenter, see Recalculated results, p. 181. 
 

The indenter information is updated in the measurement parameter area (Fig.95 ). 

 
 

4.12.3 EXPORTING THE INDENTER 

 

 
 
 

 
 

 
 
 

 
 

 
 
For each active measurement, right click in 

the measurement parameter area and select 
"Export indenter…" from context menu. 

 
The same Export a indenter file window as 

described in Import/export, p. 35 appears. 
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4.13 CHANGING THE FRAME COMPLIANCE 

To change the current frame compliance value taken to calculate the results for 

each: 
 

Active document (all measurements of its groups) 
 

- Select "Edit > Document > Change frame compliance…" from menu bar. 
 

Active group (all its measurements) 
 

 

- Select "Edit > Group > Change 

frame compliance…" from menu bar. 
 

- Right click on the group tab and select 
"Change frame compliance…" from 

context menu. 

Active measurement 
 

 
Fig.96 Frame compliance current value 

Select "Edit > Indentation > Change 
frame compliance…" from menu bar. 

 
 

 
 
- Right click in the measurement 

parameter area or on the 
measurement tab and select "Change 

Frame Compliance" from context 
menu. 
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This window allows changing of the 
current frame compliance value for the 
measurement(s) previously selected. 

 

 

To set another frame compliance value. 

 
To reset the frame compliance with the initial1 value. 

For each change of the frame compliance, the value is updated in the measurement 
parameter area (Fig.96) and the Main results and Additional results values in the 
analysis result area (below) are recalculated for each concerned measurement. 
 

 
 
 

 
 

 
 
 

 
 
1 Initial value was set in the Frame compliance field of the Indenter Ranges tab for UNHT 

(Fig.3) or Ranges tab for NHT (Fig.6) / MHT (Fig.11); see from section 2.1.3. 
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4.14 GENERATING SURFACE MAPPING (IMAGE) 

The surface mapping feature is used to create 3D image(s) from each (one at a 

time) selected result parameter of a matrix of measurements, which were 
performed at different positions on the (same) sample.  

 
This feature generates image(s) where each pixel location represents a 
measurement position and each pixel color represents a different measurement 

value of the selected result parameter. 
 

For each active group (all its measurements) 
 

 
… 

 

INFORMATION: The (matrix) 
group should contain at least 4 
measurements. 
 

Select "Edit > Group > 
Document > Generate a 

surface mapping…" from menu 
bar. 

 

Select one result parameter in the 

list (standard O&P Oliver & Pharr 
analysis method, other method(s) in 

addition if available/added). 
 
INFORMATION: Generally the 

most interesting parameters are 
HIT, HVIT and EIT. 

 
Shows the number of the measurements for the selected 
parameter. INFORMATION: The min. number should be 
4 otherwise an Information window will appear (if an 

analysis method is manually added (afterwards), it should 
be done for the other measurements of the current 

group, at least 4). 

 
To export the corresponding image (parameter selection 

above) in the gallery of the result analysis window. 

List 
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Surface mapping image are added to the gallery 
with other images (if previously grabbed). 
 

Double click the image to open it in the window 
below.  

The Edit an image window below allows some settings on the 

opened image (Title name, comments, image features…); refer to 
the Common Scratch & Indentation software reference 

guide in section Measurement Documents in Curve View / 
Manipulating Document windows / Image Gallery. 
 

 

 
To export the corresponding image (previous parameter 

selection) in .SUR file format, for an external analysis 
with another software like Image Plus; refer to the 
Image Plus software manual. 

 

 
1) To know which measurement group tab and which parameter were previously selected to 

generate the image, the Title name field is automatically filled in with this information (can 

be changed if necessary) 

  

1) 
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This window allows: 
 

 
 

Then click . 

- Choosing a location 

where to save the 
surface file. 

 

- Typing a File 
name:  
The default file 

format is .SUR 
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5 TROUBLESHOOTING 

5.1 F.A.Q. 

Refer to each corresponding Indentation head user manual or reference guide in 
section F.A.Q. 

 
 

5.2 ERROR MESSAGES WHILE USING THE INSTRUMENT 

Refer to each corresponding Indentation head user manual or reference guide in 
section Blocking error messages. 

 

5.3 UNPRINTED ITEMS 

Some indentation measurements or images are not printed on the document; this 

may occur when: 
 
Measurements unprinted 

 

 
… 

 

Under the Print extent 
area, the "Groups" 

and/or "Indentation 
tests" drop-down 
menus specify that 

"<All relevant>" 
measurements should 

be printed, and some 
groups/measurements 
are not designated as 

relevant → change 
the group(s)/ 

measurement(s) as 
relevant. 

 

Otherwise select the Print extent for each desired drop-down 
menu, 
 

"Groups > …" 

"<ALL>" or “ 'Group name' ”  
 

AND/OR 
 

"Indentation test > …" 
"<ALL>" or “indentation 'measurement number' ". 
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Images unprinted 

 

The document model specifies that only the 
relevant images should be printed, and some 
images are not designated as relevant; 

 
 

 
 

 
 
 

 
change the relevant attribute of each necessary 

image 
 

   

     
 

 

Otherwise select to print <all images> in the 
document model. 

  

Selected image 
squared blue 
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5.4 INSTRUMENT SEEMS TO BEHAVE STRANGELY 

Verify that the field values of the 'Ranges' tabs1 (in Hardware configuration window) 
match with the values stated on the calibration certificates, which are provided with 

the corresponding instrument. Otherwise change them accordingly. 
Refer to the Common Scratch & Indentation software reference guide in 
section Managing the instrument / Hardware configuration / 'Ranges' 

tab(s). 
 

 
Fig.97 'Ranges' tabs (e.g. NHT) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
1 UNHT has 3 'Ranges' tabs  
 

 NHT has 2 'Ranges' tabs  
 

 MHT has only 1 Ranges tab  
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6 SOFTWARE FORMULAS 

Graphical views of indentation parameters: 
 
 

6.1 TYPICAL INDENTATION CURVE 

 

 

 
 
 

Fig.98 Indentation test 

 
Legend 

 
 a : Application of F 
 b : Removal of F 

 c : Tangent to curve b at Fmax 

 F : test force 

 Fmax : maximum test force 
 
 hp : permanent indentation depth 

 hr : tangent indentation depth 
 hc : contact depth of the indenter with the sample at Fmax 

 hmax : maximum indentation depth 
 S : contact stiffness 
 ε : geometric constant 

  

hmax hp hr hc 

ε∙(hmax–hr) 

F 
Fmax 

h 

b 

a 
S 

c 
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6.2 SCHEMATIC REPRESENTATION OF INDENTER-SAMPLE CONTACT 

 

 
 

 
 
 

 
 

 
 
 

 

6.3 PARAMETERS DETERMINATION 

Fmax: Directly on curve 
 
S (Tangent method): Tangent fit: Fit start: 95 % of Fmax 

 Fit end: 70 % of Fmax 

 m

S 







=

dh

dF
 

 
 

m, hmax, hp and S (O&P method): 

 

 Power law fit of unloading curve: 

 
 Fit start: 98 % of Fmax 

 Fit end: 40 % of Fmax 

 

 Equation: 

 

 

m

pmax

p

max
hh

hh
FF















−

−
=

 
 Where m, hmax, hp are fitting parameters. 

INFORMATION: 
 

- In case of creep or viscoelasticity still occurring during unloading, it may happen 
that the hmax value in the results cannot be seen as a data point on the curve. 
 

- Due to complex behavior of contact mechanics at the end of the unloading curve 

(roughness, tip shape, creep, viscoelasticity…), it may happen that the hp value in 
the results cannot be seen as a data point on the curve.

 

  

h 

hs 

hc 

hp a 

Initial surface Surface profile 
after load removal 

Surface profile 

under load 

Indenter 
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Calculation of S: 

1

pmaxmax )h(hFmS −−=
 

 

hr: Intercept of the tangent to the load-displacement data at 
the maximum load on unloading (S) with the depth axis. 

 SFhh maxmaxr −=  

 

hc: )h(hεhh rmaxmaxc −−=  

 
: Depending on the diamond shape 

 

Indenter Shape m  

Flat Punch 1.0 1.0000 

Cone 2.0 2( − 2) /  = 0.7268 

Sphere/Paraboloïd 1.5 0.7500 

 
In our case,  is estimated using the m value! 

(Table of 10 values and linear extrapolation between 2 values) 
 
Ref.: J. Woirgard and al./Surface and coatings Technology 100-101 (1998) 103-109 

 
 

: Geometric factor (diamond shape dependent) 

 Circular  = 1.000 

 Triangular  = 1.034 

 Square β = 1.012 
 
Ap: (theoretical or calibrated) 

( )hA p f=  
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6.4 INDENTATION HARDNESS (HIT) 

6.4.1 DESIGNATION OF HIT 

HIT = 0.5/10/20/30 = 222 000 N/mm2 

 
HIT 

 
Time taken to remove F during the fitted portion of 

F removal curve in sec. 
 
Time for holding Fmax in sec. 

 
Application time of F in sec. 

 
F in Newton 

 

 
6.4.2 DETERMINATION OF HIT 

HIT is a measure of the resistance to permanent deformation or damage. 

 

p

max

IT
A

F
H =

 in Pascal 

 

Ap (theoretical or calibrated) 
 

 
The determination of the exact area function for the given indenter is 

required for indentation depth < 0.006mm (tip defect). 
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6.5 INDENTATION MODULUS (EIT) 

6.5.1 DESIGNATION OF EIT 

EIT = 0.5/10/20/30 = 222 000 N/mm2 

 
EIT 

 
Unloading time from holding time end to last 

contact point 
 
Holding time in sec. at Fmax in sec. 

 
Loading time in sec. from contact to Fmax 

 
F in Newton 

 

 
6.5.2 DETERMINATION OF REDUCED MODULUS (ER) 

The reduced modulus is calculated from the following equation: 

 

( )cp

r
hA

S
E




=





2  

 
 

6.5.3 DETERMINATION OF PLANE STRAIN MODULUS (E*) 

E* is calculated from the following equation: 
 

i

i

r EE

E
211

1
*

−
−

=
 

With: 
 

Ei = Elastic modulus of the indenter (diamond 1141 GPa) 
i = Poisson’s ratio of the indenter (diamond 0.07) 
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6.5.4 DETERMINATION OF EIT 

EIT calculated from the E* using a an estimated sample Poisson’s ratio (s): 

)1(*
2

sIT EE −=
 

 
As a reminder, typical values of s are: 

 
 ● Ceramic: 0.1 to 0.3 
 ● Metal: 0.2 to 0.4 

 ● Polymer: 0.3 to 0.4 
 

6.6 STANDARD MEASUREMENT OF VICKERS HARDNESS (HV) 

6.6.1 DESIGNATION OF HV 

 
 HV = 0.1 Vickers 

 
Hardness value 

 
 

6.6.2 DETERMINATION OF HV 

( )cc

max

hA9.81

F
HV


=

  in Vickers (kgf/mm2) 

 
(diagonal measurement) 

 

 



=== 68sin

D

F2
68sin

A

F

A

kgfF
HV

2

pd
 

2D

F
8544.1HV 

 

768tan22
h

D
=  

 
Where: 

h is the indentation depth under applied load (corresponding to diagonal D) 
  

D 
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6.7 ESTIMATION OF HVIT WITH INDENTATION HARDNESS (HIT) 

 
   

 skerVicHV
sin

9.81

sinA

kgF9.81

A

NF
MPaH IT

dp

IT 


=



==

 

 

With Vickers indenter: 
 

580.10HHV ITIT   

 
With Modified Berkovich indenter (M. Berkovich): 

 

800.10HHV ITIT   

 
 

6.8 INDENTER DEFINITION & SPECS, WITH AREA FUNCTION RELATIONSHIPS 

For indentation depth > 0.006mm, a first approximation to the projected area may 
be used: 

 

 

 
Vickers Berkovich M. Berkovich Cube Corner 

αt 136° 141.9° 142.3° 90° 

α 68° 65.03° 65.27° 35.264° 

Ad / h2 


2cos

sin
4   




2cos

sin
33   




2cos

sin
33   29  

≈26.43 ≈26.43 ≈26.97 =4.5 

Ap / h2 
2tan4   2tan33   2tan33   233  

≈24.504 ≈23.96 ≈24.494 ≈2.598 

Ad / Ap 
sin1  sin1  sin1  33sin1 =  

≈1.0785 ≈1.1031 ≈1.1010 ≈1.7320 

 

αt = total included angle 
α = angle between the axis of the diamond pyramid and the 3 faces 

Ad = Ac = As = (developed) contact area 
 
Reminder: 

 
Ap = projected contact area 
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6.9 MARTENS HARDNESS (HM) (FORMER DESIGN: UNIVERSAL HARDNESS HU) 

6.9.1 DESIGNATION OF HM 

HM = 0.5/20/20 = 8700 N/mm2 

 
HM 

 
Duration time of F in sec. 

 
Application time of F in sec. 
 

F in Newton 
 

 
6.9.2 DETERMINATION OF HM 

HM is measured under applied F. 
HM is determined from the values given by the F/h curve during load time, 

preferably after reaching the specified F. 
HM includes the plastic and elastic deformation, thus this hardness value can be 

calculated for all materials. HM value is defined for both pyramidal indenters 
(Vickers and Berkovich). It is not defined for the Knoop or ball indenters. 
 

HM is defined as F divided by the surface contact area of the indenter penetrating 
beyond the zero point of the contact: 

 

 
(h)A

F
  HM

s

=
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• Vickers indenter: 
 

( )
( )

2

2s h
αcos

αsin  4
(h)A 


=

  and 2

s h26.43

F
  

(h)A

F
  HM


=  

 

• Perfect Berkovich indenter: 
 

( )
( )

2

s h
αcos

α  tan  3 3
(h)A 


=   and 2

s h  26.43

F
  

(h)A

F
  HM


=  

 

• Modified Berkovich indenter: 
 

( )
( )

2

s h
αcos

α  tan  3 3
(h)A 


=

 and 2

s h  26.97

F
  

(h)A

F
  HM


=  

 

HM is usually followed by the test condition in the following order: 
 

- F in N, 

 
- the time for the application of F in sec. 

 
- the time during Fmax is kept constant in sec. 

 

- after equals sign, HM value. 
 

Examples: 
 

• HM 0.5/20/20 = 8700 N/mm2  

 
HM is 8700 N/mm2, determined with a F of 0.5N, applied in 20s, constant during 

20s. 
 

• HM(Berkovich) 0.5/20/20 = 8700 N/mm2 

 
 

Same as above but with a Berkovich tip instead of the standard Vickers tip. 
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6.10 INDENTATION CREEP (CIT) 

6.10.1 DESIGNATION OF CIT 

CIT = 0.5/10/50 = 2.5 % 
 

CIT (relative change of indentation depth) 

 
Time (t2 – t1) for holding constant F in sec. 

See Fig.99 
 
Application time of F in sec. 

 
F in Newton 

 
 
6.10.2 DETERMINATION OF CIT 

100
1

12 
−

=
h

hh
CIT  

Where: 

 
h1 is the indentation depth at time t1 of reaching F (which is kept constant) 
 

h2 is the indentation depth at time t2 of holding the constant F 
 

 
Fig.99 Expression of CIT 

 
a: Application of F 
b: F constant from t1 to t2 
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6.10.3 CREEP ANALYSIS 

This analysis is used to determine the viscoelastic properties from the creep curve 

(pause at constant force) with a sphere only. 
 

 
 

Example for the case of 2 elements 
 

 

 

 
 
The material response can be described with the following creep function: 

(1) )/texp(C)/texp(CC)t(J 22110 −−−−=  

 
Then the indentation depth follows the below equation: 

(2) )/texp(B)/texp(BB)t(h 22110

2/3 −−−−=  

(for 1 element the constant terms are B0 and B1 whereas for 3 elements there are  

B0, B1, B2 et B3) 
 
The analysis performs a fit of the indentation depth h(t) between tR and (thold+tR ) 

using the equation (2) giving the fit parameters of B0, B1, B2, 1 et 2  

 

Then the results are calculated using the following equations: 
 

(3) )R8/(3FG =  tip Geometry Factor, where R is sphere radius 

 

(4)  1)/texp(
t

RCF 1R

R

1
1 −


=  Ramp Correction Factor 

 

(5)  1)/texp(
t

RCF 2R

R

2
2 −


=  

 

tR 
t 

h(t) 

thold+tR 

1 2 
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(6) 
Gm

0
0

FF

B
C =  where Fm is the max. test force 

 

(7) 
1Gm

1
1

RCFFF

B
C


=  

 

(8) 
2Gm

2
2

RCFFF

B
C


=  

 

(9) 
)CCC(2

1
G

210

0
−−

=  

 

(10) 
0C2

1
G =  

 

(11) )1(G2G −= 


 shear modulus - where  is the tested 

  material Poisson’s ratio 
 

(12) )1(G2E += 
 elastic modulus 

 

(13) 
)21(3

E
K

−
=  bulk modulus 
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6.11 INDENTATION RELAXATION (RIT) 

6.11.1 DESIGNATION OF RIT 

RIT = 3/10/50 = 0.01 % 
 

RIT (relative change of F) 

 
Time (t2 – t1) for holding constant F in sec. 

See Fig.100 
 
Application time of F in sec. 

 
F in Newton 

 
 
6.11.2 DETERMINATION OF RIT 

100
1

21 
−

=
F

FF
RIT  

Where: 
 

F1 is the force at reaching the indentation depth, which was kept constant, in N 
 

F2 is the force after the time during which the indentation depth was kept constant, 
in N 

 
Fig.100 Expression of RIT 

 

a : Application of the indentation depth 
b : Indentation depth kept constant from t1 to t2 
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6.12 ELASTIC PART OF INDENTATION WORK 

100=
total

elast
IT

W

W


 

With: 
 
Wtotal = Welast + Wplast 

 
Plastic part Wplast / Wtotal follows as 100 % − ηIT 

 

 
  

Wplast Welast 

Fmax 

hmax 

h 

F 
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6.13 TANGENT METHOD 

The Tangent Method is also called the Linear Extrapolation Method.  This assumes 

that the first portion of the unloading curve is linear and simply extrapolates 
that linear portion to intercept the displacement axis.  This method is 

applicable to materials that show a high degree of stiffness and a large deformation 
so that the unloading curve is, to a good approximation, linear. 
 

A simple linear fit through the upper part of the unloading data intersects the depth 
axis at hr 

 
S is given by the slope of this line 
 

hc is then calculated as: 
 

( )rhhh −−= maxmaxch   

Where: 
 

 depends on the indenter shape. 

 
 

6.14 POWER LAW METHOD (OLIVER & PHARR) 

The Power Law Method recognizes the fact that the first portion of the unloading 
curve may not be linear, and can be described by a simple power law 

relationship: 
 

( )m
phhkF −=  

Where: 
 

k is a constant and m is an exponent which depends on indenter geometry 
 

A power law function is used to describe the upper part of the unloading data. 
m

pmax

p

max
hh

hh
FF















−

−
=  

Where: 

 
The constants m and hp are determined by a least squares fitting procedure 

 
S (= 1 / C) is given by the derivative at peak load: 

 

( )
( )

( ) 1

pmaxmaxm

pmax

1m

pmax

max

max

hhFm
hh

hh
Fm

dh

dF
S

−

−

−=














−

−
=








=  
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hr is thus given by: 
 

S

F
hh max

maxr −=  

hc is then: 

 

( )rmaxmaxc hhεhh −−=  

Where: 

 
 now depends on m 

 
The tangent is found by differentiating the unloading curve and evaluating at Fmax 
 

The intercept of this tangent with the displacement axis yields hr 
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